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Tutorials

This section contains tutorials which will show you to access your Adabas database using SOA
Gateway in an exemplary way, based on a number of programming languages and standard
applications which have built-in SOAP facilities or extensions.

It also contains tutorials detailing how to set up and use the Usage Governace capability offered
by SOA Gateway.

There is a tutorial demonstrating how EntireX can be used as a transport for SOAP messages to
SOA Gateway.

® Adabas Tutorials
= Usage Governance Tutorials

= EntireX Tutorial
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1 Adabas Tutorials

The Adabas tutorials are based on the well-known Adabas 'Employees' file. The following sample
Resource definitions are put in place by the SOA Gateway server install process:

® adabas_Employees

® adabas_Employees_9

® adabas_Employees_special

® adabas_EmployeesMini

adabas_Vehicles

The default Adabas Database ID preset for the demo files is 212, which may not reflect the actual
Database ID in your environment, so these will need to be adjusted before trying to run the sample
programs. Please familiarize yourself with the SOA Gateway Control Center functions required
to achieve this before continuing the tutorials trail.

Basic Tutorials
The basic tutorials cover the following areas:

® Using Java (Axis2) wrapper classes
® Using the PHP SOAP Extension

= Using Ruby

® Using C#

® Using soapUi

® Using Microsoft Office : Infopath

Advanced Tutorials

Dealing with LOBs (Large OBjects)




Adabas Tutorials

Preparing the LOB file
Using LOBs with soapUi
Using LOBs with PHP

Using LOBs with your favourite browser

Dealing with Transactions

Transactions using soapUi

Samples

This section also includes the following demo files and code samples that you can try out:

Tut_02_List.java

ex01_SoaGatewayFirst.php
ex02_SoaGatewayEmpList.php
ex02a_SoaGatewayEmpListDescending.php
ex02a_SoaGatewayEmpListSorted.php
ex06_SoaGatewaySpecial_SubDescriptor.php
ex06_SoaGatewaySpecial_SuperDescriptor.php
ex03_SoaGatewayEmpAdd.php
ex04_SoaGatewayEmpGet.php
ex05_SoaGatewayEmpDel.php
ex10_SoaGatewaySimpleForm.php
ex15_SoaGatewayUpdateForm.php
empMiniList.rb

ASGDemo.cs

Tutorials



2 Using Java (Axis2) wrapper classes

Tutorial: Generate a Java wrapper for the "Employees" file
Java wrapper/stub classes are generated using the Apache Axis2 feature WSDL2Java.
If you do not have it already, download and install the latest Axis2 kit.

These are the steps required to generate the Java wrapper classes for the "adabas_EmployeesMini"
DataView supplied with SOA Gateway:

1. Create a new Java-project (refer to Getting started with Eclipse), name it "JavaEmployees"

2. Right-click the "JavaEmployees" project folder, select "Build Path", then "Add External Archives..:"



http://axis.apache.org/axis2/java/core/
http://axis.apache.org/axis2/java/core/docs/userguide-creatingclients.html

Using Java (Axis2) wrapper classes

4 l:E"a JavaEmployees |

x &

C.

Mew
Go Into

Open in New Window

Open Type Hierarchy
Show In

Copy

Copy Qualified Mame
Paste

Delete

Build Path
Source
Refactor

F4
Alt+Shift+W »

Ctri=C

Ctrl+V
Delete

Allt+Shift+5 »
Alt+Shift=T »

o rEG B

Link Source...
Mew Source Folder...

Use as Source Folder

Add External Archives...

Add Lihruli&.

Configure Build Path...

Date modified

] activation-11 jar

08.10.2009 15:31

Executable Jar File

& axiom-api-1.28 jar

08102009 15:31

Executable Jar File

(| aiom-dom-1.2.8jar

08102009 15:31

Executable Jar File

1| mdprn-imgl-12.8 jar

08.10.2009 15:31

Executable Jar File

] anisZ-adb-1.5.1jar

19.10.2005 10:58

Executable Jar File

1™ Cormputer -

& amis2-adb-codegen-1.51 jar

15.10.2009 11:01

Executable Jar File

] ade2-ant-plugin-1.5.1 jar

19102009 11:42

Executable Jar File

| axis2-clustering-15.1 jar

19.10.2009 1104

Executakie Jar File

| anisZ-codegen-1.5.1jar

19.10.2009 10:59

Executable Jar File

o] anis2-corba-15.1 jar

19202009 11:45

Executable Jar File

139 KB

] anis2-fastinfoset-1.5.1 jar

19102009 11:02

Executable Jar File

70 KB|

| axis2-java2wsdl-1.5.1 jar

19.10.2009 1101

Executakie Jar File

26 KB|

| mnis2-jaeic1.5.1. jar

19102009 11:04

Executake Jar File

P

File name: ~XmiSchema-14.3jar” “activation-1.1jar" “axiom-api-1.28 jar" "axn + [-.F"-"P

)

Open ] [ Conce
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Using Java (Axis2) wrapper classes

3. Open a command prompt (aka "DOS box"), change to the "JavaEmployees\src" directory and
run the following command

wsdl2java -uri http://<yourserver>:<yourport>/adabas_EmployeesMini?WSDL -o ..\
-p So0aG

B Clwindows\system3Zcmd.exe: N Y

sMini7WSDL -0 ..\ -p Soal

ATION DIRECTORY /schema/public smlmime .,

The following items are generated from a SOA Gateway WSDL:
" A "Stub" class implementing all types and operations ( ports / bindings )

= A CallbackHandler - a stub class (not used in this tutorial) providing hooks for client-side
extensions to the generated result- and error handlers.

= A Fault class

4 = lavaEmployees
4 |8 gre
H (default package)
4 H SoaG
1] AdabasEmployeesMiniServiceCallbackHandler.java
1] AdabasEmployeesMiniServiceStub.java
|4] Fault.java

4. Add anew Java class named "Tut_02_List" to the project ( File -> New -> Class ), opt to create
a "main" method, click "Finish".

Tutorials 5



Using Java (Axis2) wrapper classes

Source folder JavaEmployess/src

Package:
| Enclosing type:

Tt 02_List
@ public () default piivate
[ abstract [ final [] static

Jovalang Obgect

protected

ot

Broawse...

Which method stubs would you like to create?
[¥] public static void main(String(] args)
[7] Constructors from superclass
[#] Inherited abstract methods

Do you want to add comments as configured in the properties of the current project?

|| Generate comments

5. Remove the generated code from the newly added class entirely, use (paste) the code from
Tut_02_List.java to create your first test program accessing ADABAS data via SOA Gateway.

6. Run the program as a "Java Application”

Tutorials



Using Java (Axis2) wrapper classes

(et /s oty — O D T2 tijma 32N
@B g 7| 19import Scas.t:
« &3 Javetmelogees 2 import SoaG.AdabasEmployeesMiniServiceStub.*:
‘B :!' * The S50A Gateway LIST method will T all data matching the []
he S0A Gateway LIST meth J return patching the
4 m [U:f;ulpwcl_ug.c] 138/« Hit Ctrl+S to sa the file,
4" 14 * The IDE will autcmatically build the file, and display
s [B Mew L2 15 +~ errors and warnings in the “Problems” view.
» 16 * How add the class definition and the main method.
Open =3 1 bns
E Open With » 18
;] Open Type Hierarchy [ 19 public class Tut_02_Lisc {
v = JRE - 20
Show In AlesShift+ W »
» mA Refq 215 puoblic static void main(Stzingl] azgs) {
Fbuil 5 copy CtreC 22
5 Copy Qualified Name - ey i
L 2 24 AdabasEmployeesMiniServiceStub stub = new AdabasEmployessMiniServiceStub()r
[ Paste Crl+V 25
#® Delete Delete 26 AdabasEmployesKeyType keys = new AdabasEmployssHeyType():
27 keys.secPersonnel 1d("30005%");
Euild Path » 28 keyas.setlity (") ;
Source AltsShifte5 ¥ 28 keys.setlame (") 7
Refactor BisshifesTr | 27
31 AdabasEmployesliscElement liscKey = new AdabasfmployeelListElement () :
i Import... :; listKey.sethdabasEmployeeLiatElement (keya);
A ) 31
= F 34 AdabasEmployessMiniElement result = null;
References » 35
D & 36 result = stob.lisc(liscKey, noll, moll);
i a7
& R 5 - YT e M4 Tl aman e T weer = vasnle sashAss e o el TTTTL PRI
e | [2. Problems | @ Jsvadac [, Declaration [ B Consale 51
Run As *| o8 1RunonServer Alt+Shift+X, R [\SysTook\ava\jref\bin\javaw.exe [22.08.2010 01:33:51)
Debug As LB {ws] lea.ﬂppltgaﬁon A+ Shift+ X, J
petiet * ) Open Run Dialog...
Validate I

7. The output appears in the "Console" window:

a

([£1 Problems | @ Javadoc (& Declaration () Console &3, w %X %|GaiEE) 297
<terminated> Tut_02_List [Jave Application] CA\SysTools\lava'jref\bin\javaw.eoe (22.08 2010 09:34:45)

umber of record xead: 9 -
Record [0]Perspnnel Id=50005000, Mame=EIDDE, Firast Name=MAURICE, City=APT

Fecord [l1]Personnel Id=50005200, Hame=RAMAUGE, First Hame=RNDRE, City=LYON

Record [2]Personnel Id=50005300, Hame=MAIZIERE, First Name=ELISABETH, City=PARIS

Record [3]Personnel Id=50005400, Hame=0NILLOM, First Name=JEAN-PIERRE, City=LE LUC-EN-BROVENCE
Record [4]Personnel Id=50005500, Name=BLOND, First Hame=ALEXANDRE, City=ST-ETIENNE

Record [5]Perscnnel Id=50005600, Hame=MOREMNO, Firsc Name=HUMBERTO, Cicy=VIENHE

Record [6]Personnel Id=S50005700, WHame=LENZ, First Name=PHILIFFE, City=COLMAR CEDEX

Record [7]Personnel Id=50005800, Hame=ADAM, Firsc Name=SIMONE, City=JOIGNY

Record [8]Personnel Id=50005900, Hame=BODIM, First Name=ERSTOM, City=SAVIANGES

4 L3

8. This sample selects all "Employees" records with a personnel-id of 50005nnn, you may want to
experiment varying the key data, this is easily done by modifying the properties passed to the
generated classes. E.g. try the following to list all records for "Employees” whose names start
"SMI", living in cities with names starting "D".

keys.setPersonnel_id("");
keys.setName("SMI*");

keys.setCity("D*");

Tutorials 7



Using Java (Axis2) wrapper classes

The following Java/Axis2 tutorial programs are available:

Tutorial What it does

Tut_0la_Getjava GET a single record by Personnel Id
Tut_01b_GetByISN java GET a single record by ISN

Tut_02_List.java LIST some records

Tut_03a_SelectSimple.java SELECT by a range of Personnel IDs
Tut_03b_SelectSorted.java SELECT by a range of Personnel IDs and sort by Name

Tut_03c_SelectConversational.java |[SELECT by multiple ranges of Personnel IDs, returned in "chunks" of
20 records each

Tut_04a_AddUpdateDelete.java |ADD + UPDATE + DELETE in "autocommit" mode

Tut_04b_AddTransactionaljava |ADD in a transactional context

8 Tutorials




3 Accessing Adabas using the PHP SOAP extension
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Accessing Adabas using the PHP SOAP extension

This tutorial

® Demonstrates how to access SOA Gateway from a PHP script

® Provides a number of PHP examples.

What is PHP ?

PHP is a widely-used general-purpose scripting language that is especially suited for Web devel-
opment and can be embedded into HTML.

The PHP interpreter is available as source code or as pre-compiled binaries for major platforms,
including most Linux™ distributions, Windows®, Mac OS X, and iSeries™.

The latest release is PHP 5 and is seeing increasing adoption. PHP 5 introduces improvements to
the object model; also, the underlying memory management has been redesigned with multi-
threading and performance in mind.

For more information about PHP, or to download the software, please refer to the PHP homepage.
New in PHP 5 is a built-in SOAP extension. It is supplied as part of PHP.

For this tutorial to work, you should have PHP 5 up and running in your Web server, see the in-
stall.txt document in the PHP distribution library for details.

Installing the Eclipse PHP Development Tools

The Eclipse PHP Development Tools (PDT) are not absolutely necessary, but using Eclipse greatly
simplifies the development process. This tutorial assumes the PDT to be installed.

Please refer to the Eclipse PDT project pages for installation and configuration instructions.

Accessing Adabas from PHP

1. First, create a new project within your workspace.

10 Tutorials


http://www.php.net/
http://www.eclipse.org/pdt/install.php

Accessing Adabas using the PHP SOAP extension

& Java - Eclipse SDK

BC]

2. Opt to create a PHP Project, click Next

& New Project

Select a wizard
Create a PHP project

Wizards:
type fiter text

& = General
® = Edipse Modelng Framework
t = Java
== PHP
&
# = web
® = Examples

(]
%
5
¥

- B

Alt4-5hift+-M

Ml Project...

| £ Package

(& Class

W Inkerface

ﬁ’ Enum

(@ Annotation
& Source Folder

| % Folder

Give the project a name and unselect the "Use default" box. Browse to the default location of
your html documents, in this case an Apache server document folder called "ASGdocs", click

Finish

Tutorials
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Accessing Adabas using the PHP SOAP extension

Project contents:
] Use defaut = /
Directory: | E:\servers\Apache 20\Apache Zhtdocs \asgdocs '

PHP Version

] Enable project spedfic settings Configure Workspace Setiings

If you are asked to switch to the PHP perspective, opt to do so

& Open Associated Perspective?

2 This kind of project is assadated with the PHP perspective. Do you want bo
q,) open this perspective now?

[ memember my decision

3. Create the PHP SOAP client

Create a PHP script file by right-clicking into the Eclipse Navigator area, select New -> PHP
File

12 Tutorials



Accessing Adabas using the PHP SOAP extension

P e

¥ 44 Demo

L+
- ',Php PHPdemo

|=| project
= Project..

o Inko
Open in Mew Window [d PHP File

[ c [ Folder
] =0PY
i3 L File
¥ Delete = Example. ..
Mowve. .. Z
Rename ] Ckher.,.. Ckrl4-M
| g Import... [ l

Specify a File name, click Finish

PHP Mew File
This wizard creates a new PHP file,

Browse, ., |

Container: ] IPHPdemo

File name: ] PHPempMini. php

A

Zancel

13
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Accessing Adabas using the PHP SOAP extension

Opt to create a "Simple PHP File"

€ New PHP File N =5
Select PHP Template

Select a template as initial content in the PHP page.

[] Uize PHP Tamplate

Templates ane "MNew PHP™ templates found in the PHP Templates praferance page.
Mame Description

Heaw PHP file - HTML framesst himl 4.01 frameset

Hew simplePHP fle | phe
Preview

< php

§{cursor}

>

® [gnsn ][ concd ]

The PHP SOAP class to represent the Adabas Service is called SoapClient, the first step will be
to instantiate SoapClient, passing the URL of an SOA Gateway WSDL as the parameter:

Bl *PHRempMini.php =i B
< ?php
faoapclient = new SoapClient |
"http://Soagatevin: S0582 fadabas_Emp loyeesMini ?WIDL™
1
3 =

Now that we have instantiated our client we want to see what methods it provides and what

parameters are required. Fortunately we can get PHP and the instantiated SoapClient class to
do most of the work for us easily:

ffunctions = §=

apclient-> getFunctiona(]:
print riffunctions):

=),

If you run this as a console application (via "Run") the output is much better formatted than
running it in the PHP browser. The console window will show the following;:

14 Tutorials



Accessing Adabas using the PHP SOAP extension

Problems B NEGER RS Bookmarks | PHP Browser % gl B

<terminated = PHPdemao [PHP Application] PHP D:iServers\phpS12iphp-win.exe | PHPemphini.php
Array
[
[0] =2 adabasEmployeesElementType list (adabasEmployeeKeyType fadabasEmployeelistHeyw)
[1] => adabasEmployeesElementType get (adsbasEmployeePrimaryEeyType fadabasEmployeeGetKey)
[2] => operationResult delete(adabasEmployeePrimaryKeyType #adabasEmployeeleleteley)
[3] == operationRBesult add|{adabasEmployeesType SadsbasEmployess)
[4] == operationResult update (adsbasEmployeesType fadsbasEwmployeesUpdate)

This shows that the service described by the WSDL provides five operations: list, get, delete,
add and update; It also lists the required parameters and the responses given.

A description of the input and output parameters can be retrieve by calling the __getTypes
class:

= fsoapoclient-» getTypes():

The output will look like this:

Tutorials 15



Accessing Adabas using the PHP SOAP extension

This information is sufficient to construct the first simple call to the "list" operation.

First an array of the required input parameters needs to be constructed:

= T S A

fAhdabasEmployeelistEey = array |
'personnel id'=:> '300001%', 'firstHame'=>'',6 'mame'=>'"', 'ecity'=>'");

Ready to invoke the "list" operation as a method of the soapclient class:

Ldshasresponse = §soapclient->list (§idabasEmploy

Now it is just a matter of taking the returned object and outputting the required results in a
table:

echo "<hr fx<br fz>":
echo "<table bhorder=1 cellpadding=5=";
echo "<trr<thrPersonnel ID</thr<thsName</the<th>City</thr<thraddress</thr</tr>";

foreach (fLdabasresponse—-radabasEmployvees-radabasEmployes as SEnploves)] |
=e—rpersonnel id</td=",

—xfirstname $Emplovese—rname</td>",
—E—roitydSeds",

=t o
foreach (! -“ﬁf—>address_line as Sadline)
echo " ine<br />";

echo "</tdr</tr>";

echo "</tahle>";

Run this in the built in PHP Browser (activated with "Window" ->"Show view" and select "PHP
Browser") or an external browser: http://<your_localhost_url>/PHPempMini.php:

16 Tutorials



Accessing Adabas using the PHP SOAP extension

Problems Console Bookmarks Badt SN a et

| http: fflocalhost: 8052 fPHPempMini. php
Personmel II) | Name City Address
276 Cotmanhay Eoad
Tlzeston
20000100 Lloyd Ilkeston Derbyshire
25 Man Street
s : Eadcliffe- On-Trent
20000107 C'Brien | MNothingham e S
11 Westwood Eoad
: : Snemton
20000110 Stilwell | Mottingharm S
13 Eings Eoad
30000112 Finch | Stamford DIAILGT]
Lincs
14 Ilain Street
: Peterborough
A0000114 Eing Peterborough Morthants
23 The Paddock
Eegworth
30000124 Grebby | Derby St
112 Derby Eoad
I ATaTaTah BaE L [P Thmal vr Spﬁﬂdoﬂ
Fertig
Tutorials 17



Accessing Adabas using the PHP SOAP extension

PHP Examples

The following PHP examples can be copied from here, moved to your web server's DocumentRoot
(for example) and executed:

® First steps

® List Employees

® List Employees descending

® List Employees sorted

® List by Sub Descriptor

® List by Super Descriptor

® Add an Employee

® Get an Employee

® Delete an Employee

® A simple PHP form for accessing Adabas

® All-in-one PHP form accessing the Employees file

18 Tutorials



4 Accessing a SOA Gateway Resource from a Ruby program

= Running a Ruby program

19



Accessing a SOA Gateway Resource from a Ruby program

Ruby ( downloadable here) is an Open Source object oriented language with a very simple, yet
powerful SOAP interface.

Running a Ruby program

Ruby comes with a very powerful editor, SciTE, which not only allows editing, but also compiling
& execution of programs.

This is an example of a complete Ruby program listing all Employees with personnel-IDs starting
with 50005%, using the 'adabas_EmployeesMini' Resource that comes with the sample SOA Gateway
configuration.

% empMiniList1.rb - SciTE =3
File Edit Search View Tools Options Language Buffers Help
1 empMiniList1.rb |

1 require 'scap/wsdlDriver'

2

3 wsdl_url = "http://soagate:8023/adabas EmployeesMini ?WSDL"

4

5 soap = SOAP::WSDLDriverFactory.new( wsdl_url }.create_rpc_driver

6

7 soap.wiredump_file_base = "socapresulc"

8

Q9 param = {"pe:r.sonnel_id" =2 "50005%", "name" => "7, "cigy" =» ""}

10

11 result = soap.list{ param )

12

13 print{ "\nNumber of Employees is ", result.adabasEmployees.adabasEmployee.length, "\n\n")

14

15 —for emp in (result.adabasEmployees.adabasEmployee)

16

17 print{emp.personnel_id, ™, ", emp.name, " ", emp.first_name, "\n")

18

19 end

<

| W

When running this program, by either pressing the F5 key, or selecting Tools->Go from the SciTE
menu, an output window will be attached to the editing window, and show the result of the Ruby
query against SOA Gateway

20 Tutorials
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Accessing a SOA Gateway Resource from a Ruby program

* empMiniList1.rb - SciTE

File Edit Search Wew Tools Options Language Buffers Help
1empMiniListLrb |
1 require 'soap/wsdlDriver' =ruby empMiniListi.rb
2 Mumber of Employees is 9
3 wsdl_url = "http://scagate:8023/adabas EmployeesMini ?WSI
4 50005000, GIDDE MAURICE
5 soap = SOAP::WSDLDriverFactory.new( wsdl_url ).create_rpc_dr |20005200, RAMAUGE ANDRE
P Y ( - ) —Pe_ 50005300, MAIZIERE ELISABETH
6 ) 50005400, ONILLON JEAN-PIERRE
7 soap.wiredump_file_base = "socapresulc" 50005500, BLOND ALEXANDRE
B8 50005600, MORENO HUMBERTC
50005700, LENZ PHILIPFE
] param = {"personnel id" =X> "50005*%", "name" => "" "cit} SUUUSSUU:ADAM SIMONE
10 50005900, BODIN GASTON
11 result = soap.list{ param ) ignored element: {http://www.w3.0rg/20
=Exit code: O
12
13 print{ "\nWumber of Employees is ", result.adabasEmployees.
14
15 —for emp in (result.adabasEmployees.adabasEmployee)
16
17 print{emp.personnel_id, ", ", emp.name, " ", emp.first_name,
18
19 end
< | 3| | >
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5 Creating a sample C# application

Tutorial: A sample C# application listing "Employees”

With a service description (WSDL), a proxy class can be created with the NET Framework SDK
Wsdl.exe tool. A XML Web service client can then invoke methods of the proxy class, which
communicate with SOA Gateway over the network by processing the SOAP messages sent to and
from the SOA Gateway server. The proxy class handles the work of mapping parameters to XML
elements and then sending the SOAP message over the network.

Wsdl.exe is a Microsoft .NET tool which is used to create proxies for C#, Visual Basic .NET and
JScript .NET. In this tutorial, we will be generating C#.

These are the steps required to generate the C# wrapper class using Wsdl.exe and create / run a
program listing records from the Adabas demo file "Employees" using the generated proxy class:

1. From a command prompt, execute Wsdl.exe, specifying the URL / URI of the SOA Gateway
DataSource to be exposed, append ?WSDL to instruct theSOA Gateway server to return the
WSDL, not data:

If the Wsdl.exe is not found, open the Visual Studio command prompt via the Start Menu. This
location depends on what packages are installed, but often resides under "Microsoft Visual C#
" or "Microsoft NET Framework SDK ".

ev CAWINDOWS\system32hcmd . exe
QC :\ASGdotnet>
fiC

:MASGdotnet>wsd]l http://scagate:8082/adabas_Emplovees?WSDL
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Creating a sample C# application

2.

A single source file is generated, its name is <rootElementName>Service.cs, in this case the "root
element" within the XSD is "adabasEmployees", thus the name of the proxy class source file
adabasEmployeesService.cs

cv CIAWINDOWSisystem32iemd. exe

C:\ASGdotnet>

C:\ASGdotnet>wsdl http://soagate:8082/adabas_Emplovees?WSDL
Microsoft (R} Web Services Description Language Utility
[Microsoft (R) .NET Framework, Yersion 2.0.50727.42]
Copyright (C) Microsoft Corporation. All rights reserved.

Writing file °C:\ASGdotnet\adabasEmploveesService.cs’.

C:\ASGdotnet>

This file contains a proxy class exposing both synchronous and asynchronous methods for each
SOAP operation provided by SOA Gateway for the DataSource. For instance, for the list opera-
tion, the proxy class has the following methods: list, Beginlist, and Endlist. The list method of
the proxy class is used to communicate with SOA Gateway synchronously, but the Beginlist
and Endlist methods are used to communicate with the SOA Gateway server asynchronously.

For more information about asynchronous communication with a Web Service please refer to
the NET documentation.

Start MS Visual Studio, create a new project with File -> New - Project (or the shortcut
Ctrl+Shift+N):

24
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Creating a sample C# application

* Start Page - Microsoft Yisual Studio

File | Edit Mew Tools Test Window  Community  Help
New 3 mzﬂ Project... Chel+Shift+h |
1 Cpen P | @ web Site,, i
Close [ Eile... Ckrl+M
j Project From Existing¥%gde. ..
.Ei ave Sele ri
@ Save Al Chrl+Shift+5
rt Template The current news cl
o Setup Environment and cli
g |
Fecent Projects k
Exit
Open: Project...  |'web Site...
Create: Project, .. | weeb site. ..

Create a C# Console Application, assign a name to it, specify the storage location, click OK

Tutorials
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Creating a sample C# application

Mew Projeck .y llil
o F
Project tvpes: Templates: 28 o
=8 '\"i:sual C# ¥isual Studio installed templates
e Mindows
L Office (27 Windaws Application [l Class Library
-- Smart DBR A windows Contral Library i web Control Library
Diatabase :—g Console pplicakion @Winduws Service
L Starter Kits [ Empty Project A Crystal Reports Application
----- Tast
[#]- Cther Languages My Templates
[+ Other Project Tvpes :
[ Test Prajects ~H5earch Online Templates, ..

A project For creating a command-line application

Mame: I EmploveesList e
Location: I DHASGHONEL  — j ; Browse... :
Salukion Marme: I ErnplowveesLisk ¥ Create directory for solution

e ——ad oK | Cancel |

A skeleton class file has been generated into your project workspace, with the required class
definition and an empty Main method

Prugram.cs]’fﬁtart Page ] * X
|'=)>[$Ernplcr;.-'eesLlst.F'rl:ugram j I-Li,VMaln(5tr|ng[] args) j
Eusing 3vstem! =
Lusing Svstew.Collections.Generic:
using Ivstem. Text;
[ hamespace EmployeesList
{
= claszs Program
i
= static vold Mainistring[] args)
1
B '
E '
—3
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Creating a sample C# application

4. First of all, import the generated proxy into the project, right-click on the project name, select

Add -> Existing Item

Solution Explorer - EmployeesList ]

= | & 2] &

[ =d| Properties

] References
':1*_=’| Program.cs

|on Solution EmplovessList' {1 project)

Build
Rebuild
Clean
Publish. ..

Fun Code Analysis

fudd

add Reference, ..
add \Web Reference. .

Wiew Class Diagram

Sek as StartUp Project
Debug

Cuk

select the AdabasEmployeeService.cs proxy, click Add

Mew Ikem

Exisking Item...

& B mEDEE

Mew Folder
Windows Earm. ..
User Contral, ..
Component. ..

iZlass...

Tutorials
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Creating a sample C# application

Add Existing Item - EmployeesList - 2 x|

Lackin:  [i5) AsGdotnet | @-@ Q4 X L E

EmployeesList
@ CIEmployeeslist_ws2003

adabasEmploveeseryice, cs

+ Tools =

My Cormpuker

File name: I

N
fdd T I

=
Files of bype: I'-.-'isual C# Files {*.cs;* resx;* settings; ¥, xsd; * wsdl) j Cancel

The proxy has been added to the project

Solution Explorer - Solution ‘Employees ]
RREEA
: Solution ‘EmployeesList' (1 project)
=k E EmployeesList
=d| Properties
-- :g References

asEmplovesservice, cs

o ':__] F'ru:ugram £s \

You now need to add a reference to the NET System.Web.Services component implementing
the SOAP interface. In the project explorer, right click on the project name, select Add Reference
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Creating a sample C# application

Solution Explorer - EmployeesList k|
= SR A

Lo Solution ‘EmployvessList’ (1 project)

= E EmployeesList

- (=4 Prd [#  Build

=] Rel :
..... l:__ﬁ_‘j ad Rebuild
i ':._Q Pro Clean

Publish. ..

Fun Code Analysis

Add 3

_*"' Add Reference. .,

Add Web Reference. ..

Scroll down to System.Web.Services, click to select it, click to select it, click OK to import the
reference
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Creating a sample C# application

MET |CDM I Projects I Browse I Recent I
_omponent Mame = Yersion Funtine Path :I
System, Runkime. Remoking  2.0.0.0 w2 0,50727 CiWINDOWS\Microsaof,
Swstem.Runkime, Serializ... 2.0.0.0 w2 050727 CHOMWINDOWSMicrasaf,
Swskbem, Security 2.0.0.0 w2 050727 CHMWIRDOW S Microsaf,
Syskem. ServiceProcess 2.0.0.0 w2 0.50727  CHWINDOW S Microsaf,
System, Transackions 2.0.0.0 w2 0,50727 CiWINDOWS\Microsaof,
System.\Web 2.0.0.0 w2, 0,50727  COWINDOWS \Microsaof,
Swskem. Web.Mobile 2.0.0.0 w2, 0.50727  CHMWIRDOW S Microsaf,
Swskem.Web,RegularEx,... 2.0.0.0 w2 050727 CHWIRDOWSIMicrasaf,

Syskem,Web, Services

w2 [0.50727
LSS e L8

Syskemn, Windo w2, 0,50727  CHWINDOWSMicrosof,
System, xml 2.0.0.0 w2 0,50727  COWINDOWS \Microsof,
wisCor 2.0.0.0 w2, 0,50727 C:'I,WINDGWS'I,MiI:rDSDF.J
Y15harpCodeProvider 2.0.0.0 w2 050727 CHOMWINDOWSMicrasaf,
wisjbi 2.0.0.0 w2, 0.50727  CHMWIRDOW S Microsaf,
jslil:l Z2.0.0.0 w2, 0,50727  CHMWINDOW S Microsof, ™
1

CH VW IND O S Microsof

| »

oK I Cancel

5. Remove the generated code from the newly added class entirely, use (paste) the code from
ASGDemo.cs to create your first test program accessing Adabas data via SOA Gateway.

30
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Creating a sample C# application

_Program.cs|

Clusing System;

L using System.Collections.Generic:

using 3Iystem.Text;
-] namespace EmployeesList
{
class Program

{

{

keys.personnel id =

LEY
{

}
{

return;
}

Console.WriteLine ("exception:

] static wvoid Maini(stringl[] args)

adabasEmp loyeesiervice emplService;
adasbasEmp loyeeKeyType keys;
adsbasEmp loyeesE lement Type result:
adabasEmp loyeeType[] empl;

keys = new adabasEmploveeKeyType();

mIooooow';

emplService = new adsbasEmployeesSerwvice():

result = empli3ervice.listikeys):

catch (JystemException ex)

empl = result.adsbasEmployees;

" 4+ ex.Message):

EANET] ke

6. Build the application. Right-click on the project name in the project explorer, click Build

Solution Explorer - EmployeesList

= 2EE &

[ =d| Propetties

_: Solution 'EmploveesList' (1 projec
= E EmployeesList

EI 7 References
' 2 System
- <3 System.L

b o Syskem,

Febuild
Zlean

Publish, ..

7. Open a command window, change to the project's build-directory Execute the compiled console

application, EmployeesList, the output will look as follows:

Tutorials
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Creating a sample C# application

MWINDDWS' system32 cnd.exe

D:~ASGdotnet~EmployeezList> yegzLiztsbhin~Debug>*EmploveezList
of Employees returne
[B]. Personnel_Id= MHame=Smith,. First_Mame=Frank
[11, - Mame=Turner, Firzt_Mame=John
[2]1, Personnel_Id Mame=Winterton, First_Mame=Rohert
[31. Personnel Mame=8ingh, First_MName=Mumtaz
[4]1, Perszonnel_I Mame=Tyson, First_MName=Jane
[5%]1. Personnel_I Hame=Mellor, First_Hame=Amanda
[6]1, Personnel_I Mame=0akden, First_Mame=Paul
[7]1. Perzonnel % Mame=Richmond,. First_MName=Alan

I

o)
o
)
A
=]
=2
=
o
[}
—
=9
1l

=]

="TR="]=Tg=T= =T~
L L (| [ [

[8]1. Personnel Hame=Deakin, First_Hame=Denise
[9]1. Per=zonnel Mame=Garfield. Firszt_Mame=James

D:~ASGdotnet“EmployeesListsEmployeesListshinsDebug >

8. This sample selects all "Employees" records with a personnel-id of 4000004n, you may want to
experiment varying the key data, this is easily done by modifying the properties passed to the
generated classes. E.g. try the following to list all records for "Employees" whose names start
"SMI", living in cities with names starting "D".

keys.name = "SMI*";
keys.city = "D*;

The output will look like this:

" WINDOWS system32, cmnd.exe

D:“A%Gdotnet“EmployeesList \EmployeesList bin“Debug>EmployeezList

Humber of Employees returned: 3

Record [B]1, Personnel_Id=380088311, City=Derby,. HName=Smith, First_MName=Gerald
Record [11, Personnel_Id=386034801, City=Derby,. MHame=Smith. First_MName=Francis
Record [2]1, Personnel_Id=38638813,. City=Derby,. Hame=Smith,. First_HName=Winston

D:~ASGdotnet“EmployeesList«EmployeesListsbin“Debug>
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6 Accessing Adabas through SoapUl

This simple scenario demonstrates how to invoke operations on an Adabas DataSource exposed
as a "Web service" through SOA Gateway from SoapUI.

soapUl is a (freeware) desktop application for inspecting, invoking, developing and functional /
load / compliance testing of web services over HTTP and can be downloaded here.

Additionally, soapUI can be integrated into the Eclipse framework, read here for more information.

1. When starting soapUI for the very first time an "empty" workspace is generated, right-click on
the top-level Projects item, select New WSDL Project to create your first soapUI project.
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Accessing Adabas through SoapUlI

£ SoapUl SNAPSHOT

T WSDL Projeck

Import Project

File Tools Desktop Help
[EA| Projects

Strg-M

Creates a new wsdl project in this workspace

Save all Projects

Strg+Alt-5

@) online Help

F1

L4

Workspace Properties

Property

Yalus

File

C:h\Dokumente und E. ..

ied Moy 08 17:24:32 CET 2006: IMFO:Loading workspace From [ Dokumente und Einstellungen' Administ
wied Moy 08 17:24:33 CET 2006:WARM:Failed ko load settings [soapui-settings. xml {Das Svstem kann die o

l Details l Windows l soapui log l http log

You will be prompted for a project name, enter one and click OK:

Mew WSDL Project

Enter project name

?

. ASEWindows|

I 2K, || fbbrechen |

Specity a target location for the project files, click Save:
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Accessing Adabas through SoapUlI

X

Speichernin:  |C3 soapui '] [@

E' Create Project

Dateiname: |.C\SGWindows-snapui-prnject Ll |

Dateitvp: [XML Files {*.xml) v]

Save Zancel

2. Now import an SOA Gateway "web service" into the newly created project, right-click the
project name, then select Add WSDL from URL

£ SgapUI SNAPSHOT

Eile Tools Desktop  Help

Projects :
...... % A5 c
@dd WSDL From URL
add '-.-'u'1 #dds all interfaces in a specified WSDL URL to the current project

Generate W3OL with JBoss'WwS

Mew Testouite S5trg-T

Fename F2

Remove Entf

Save Project 5trg-5

Save Project As Strg+Umschalt-5
#) Online Help F1

Enter the URI of the adabas_Employees_special resource, as in http://<yourASGserverhost>:<your-
ASGserverport>/adabas_Employees_special? WSDL and click OK to import the webservice
definitions from the resources / WSDL
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Accessing Adabas through SoapUlI

Add WSDL from URL

Enter W5DL LRL

?

|]22,|'adabas_Employees_special?WSDL |

L oK —I [ Cancel ]

You will be asked if default requests for all operations are to be created, click Yes.

Import WSDL

? ‘ Create defaulk requests For all operations
L]

T I w ][ e |

3. Default requests have been generated for all SOA Gateway operations for a webservice, undfold
the "list" request by clicking the plus sign left of it, right-click the created Request 1, select Clone
Request, this allows for unlimited duplication of the original request, which may be desirable
when testing various options or "canning" requests.

Projects
= Bl asawindows
= adabasDemoEmploveesSpecialPortType
i add
delete
gek
lik
----- ae Request 1

'-IIJ Open Request Editor  Eingabe

o

*= add to TestCase Strg+Alt-A

Clone Request

|Creates a copy of this request l

Delete EntF

®) Cnline Help F1

Assign a name to the cloned request, click OK
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Accessing Adabas through SoapUlI

Clone Requesk

Specify name of cloned requesk

?

. list_300000s

L 2K, ]| abbrechen |

4. soapUI now opens the request document.

SoapUI SNAPSHOT B ] 1|
File Tools Ceskiop Help ‘
Projects NT= n - - 1
¥ Request: [list_300000s] - adabasDemoEmployeesSpecialPort Type#list

=By AsGwindows
= X adabasDermoErmployvesssps

P = O x [http:,l',l'asgwindows:8DZ2,|'ac|abas_EmpIDyees_special

<! ——Optional:—-->=
“Wersions=?<;/Varsion>
<! ——Opticnal:—->=

= -—0pticmal i —-=
<! ——Opticpal:-->=
<! ——Optional:—-->=
=Transactionlds?</TransactionIds
= ——Opticmal:——-=

<! =-—Optional:-->=

<! ——Optional:—-->=

i
& add Request | Response |
2 delete
7 T " = i = "E i " = " i 2
'(_—f’ get E <soapenv:Header=
-2 lisk <full:demncEuployeeSpecialHeader>

“ConwversationState=?</ConversationStates
“ConversationId=?</Conversationld=

=TransactionStater?</TransactionStatesx

<E80AGateway_Internal Adabas IEZN=?-</S80AGateway Internal Adabas IEN

<B0ACFatevay_Internal Adabas StartAtISN-?</S0ACFatevay Internal Adal

[w|
o e S T Y Y i £ Tids =5 ot 08 Gat ST ITrtarmal L
[
.L SOAP Request L Request Attachments (0) |
o 77 D
a o
Request Properties o IO TIeTT IS TR O S T DS T =
Property | value | ied Mow 05 19:04:41 CET ZDDG:INFO:lmport!ng Dperat!on lisk
Name fist_a0nnons |~ | wed Mov 05 19:04:41 CET 2006: INFC:importing operation update | . | -
I~ i LT b’

l Dietails l Windows l soapui log I http log

Remove the soapenv:Header section, everything from, and including, <soapenv:Header> to

</soapenv:Header>

This leaves you with the soap Body section, which holds all key information:
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Accessing Adabas through SoapUlI

- <
]eu:ts 4 * Request: [list_300000<] - adabasDemoEmployeesSpecialPort Type#list
-] ASEWindows
B X adabasDemoEmplayeesspd P = O x [http:,l',l'asgwindows:8Dzz,fadabas_EmpIc-yees_speciaI v] + @
ok
& add Request | Response |
-2 delete
-k et E{ “zoapenv: Enwelope xmlns:soapenv="http: //schemas_ xmlsoap. orgssoap/envelope,
i lisk | <soapenv:EBody=

gg Reequest 1 =full:demcEnployeeipeciallistElenant =
L..22 Jisk_300000s “persomnel ids?</personmel_id=
. 4 .
updae <f1rst_name>_<ff1rst_name>

“namer? < /naner
“hirthdays? = /birchday=
“oitge?<ioicyr
=department_code=>?</department_codes
=job_title=?</job_title=

=!--1 to 8 repetiticps:-->
“language_spokens?</lanquage_spokens
=leawe leftr
“leave dues?<fleawve duss
<leave_takenr?</leawvs takens
<fleave lefr:=

=dept_person=

“department codesT?< department code>
<ﬁ [

L SOAP Request L Request Attachments (0) |

M D] 231

Remove all key elements but the personnel_id, enter 300000* as the key value, the request should
look like this now, then click the green arrow to send the request to your SOA Gateway server:

el i
b = O o [http:,l',l'asgwindaws:8IIIEE,I'adaI:-as_Emprees_speciaI '] + &

uest rRespDnse |

| Request: [list_300000s] - adabasDemoEmployeesSpecialPort Type#list

Eé “zoapenv: Enwelope xmlns: soapenv="http: /S schemnas_ xml=soap.orgf=soapfenvelopes"
<soapent: Body:=
=full:demcEnployeseipeciallistElemeant =
<personnel id-300000%</personnel ids
| =4 full:dencoEnployeeSpeciallistElement =
=/soapenw: Body-

=/ zoapenv: Envelopes

5. The response will look like this - formatted XML

This response shows "simple" as well as repeating fields like MUs (multiple value fields, here:
olive arrows), PEs (periodic groups, pink arrows) and MUs within PEs (blue arrows):
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Accessing Adabas through SoapUl

Request: [list_3000005] - adabasDemoEmployeesSpecialPort Type#list

gfrf

P =G O x [http:,l',l'asgwinu:l::lws:BDEZ,I'adahas_EmplD';.-'ees_special

M

4 +

S |

@

rRequest rRespDnse |

anapenv:Envelnpe xmlns: ful l="urn:namespaces:comn. risaris/xmiddlefqe/resour[*

<soapenw:Bodyk

“rsp:adabashemncEnployeesipecialElenent xmlns:rsp="urn:namespaces: col

“adabashencEnployeesSpacial >
“demcEnployeaSpecial=
<persontiel id=30000001</personnel id=
<first _name=FRANE=/first name=-
“name>SMITH= fnane =
<middle name-JO0HN= /middle name>
<marital status=H-</marital status>
<sexrM< sax>
“birthday=710031< hirthday>
+{addre55}12 PASTURES VIEW</addresss
<address=BELIDWMOETH= faddre=s==
+{address}I{M-ISFIELD-:faddressb-
Zoity~MANSFIELD = foitys=
<zip_coderNGEZZ ZPF=/zip_code>
“countryEUTES fcount rys
<phone area coder058Z3</phone area codex
<phone rmunher>345547-</phone nunber>
<department code=FIHAOL= department code>
<job_title=ACCOUNTING MANAGER=/job_titlex
+-—‘~incnme:=—
<currency codesUEL=/currency codes=
“anrmaal salary=0000103&0< annual salary=
arzmal bonas-000000000< /annual bonus=
“antal boras>000000000< anraal bonuss
<anmial bomas-000000000</annual bonuss
<anmial bomas=-000000000</annual bonuss
<anmial bomas=-000000000</annual bonuss
antal borus-000000000</anrnual bhonus=
“antal boras>000000000< anraal bonuss
<anmaal bomas-000000000</annual bonuss
< finconek
h <income=
=ourrency coderTUEL</currency coder
<artal salary=000010050= /famnual salarys
“anrial bomas=-000000000</anmual bonuas>

<anmial bomas-000000000</annual bonuss

o QOO0 00s farmmiial o
1 |ﬁ

L SOAP Response L Response Atkachments (00 |

response kime: Sims (41470 bybes)
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7 Preparing for the LOBs (Large OBjects) samples

= | oading the LOB file into an OpenSystems database ...........ccovviiiiiiiiiiiiiii e

= | oading the LOB file into a Mainframe database
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Preparing for the LOBs (Large OBjects) samples

While the basic samples use the well-known 'Emplyoees' file delivered with Adabas, the LOBs
demo programs require loading of a small Adabas file containing LOB fields.

| Note: LOB access requires a minimum Adabas version of v6 on OpenSystems platforms,

Adabas v8 on mainframe platforms.

Loading the LOB file into an OpenSystems database

These are the steps to load the demo LOB file into an OpenSystems (Windows, *IX) Adabas data-
base:

Save FILE90.FDT on the target system.

Save FILE90.FDU on the target system, adjust the dbid, file and lobfile parameters according
to your needs.

Set the environment variable FDUFDT, for example on a Linux system: export
FDUFDT=FILE90.FDT

Run the command: adafdu <FILE9Q.FDU

The demo base' and 'LOB' files are now loaded, which can be verified with the adarep utility:
adarep db=<yourdbid>,cont

The LOB demo file is now ready to be used.

Loading the LOB file into a Mainframe database

The steps to create the LOB demo file in a mainframe Adabas database are as follows:

® Use this FDT as input to ADACMDP, specifying dummy input (DDEBAND). Sample JCL can be
found on the ADAvrm.JOBS library distributed with Adabas.

® Run the ADALOD utility, these parameters may serve as template input to the utility. Adjust
the file number and size specifications based on your requirements.

/) Important: Note that Adabas space / buffer parameters may need to be increased for LOB

access, please consult the Adabas documentation for a description of required changes to
your Adabas nucleus parameters.
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8 Using LOBs (Large OBjects) with soapUi

This tutorial shows how to add, delete and get BLOBs using SOA Gateway and Adabas.

SOA Gateway uses the MTOM specification to send/receive the XML and binary data to/from the
required web service. This involves attaching the required binary file(s) to the SOAP message,
and then transforming this into a MIME message to send across the wire.

For the purposes of this tutorial, we will use soapUi to send and receive messages to our web
service.

Other web service clients may also be used, such as PHP with the WSO2 Web Services Framework
extension

This tutorial assumes the following

" You have at least soapUi v1.7 installed.
® You are using a version of Adabas which support LOBs

® You have set up a LOB file at FNR 90.
1. Start the Control Center and add a new resource.

Enter the following information

Name: adabas_blobs

® DataView : Select 'adabas_photoblobs', which is one of the sample definitions delivered with
SOA Gateway

Databaseld: 212 ( or the DBID relevant on your system )
FileNumber: 90

Publish your changes to the server.

2. Start soapUi, and add the WSDL for the adabas_blobs service. If you are unfamiliar with soapUi,
please run through this tutorial first
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Using LOBs (Large OBjects) with soapUi

3. You should now have a screen similar to this

soapUl 1.7.1

“i

0w 13

-1 b

-
11

L
Progect Propertss

[ Froperty Vil |

Under add double-click Request 1

4. Remove the <soapenv:Header> element and all child elements.
Add the personnel_id of the record you would like the BLOB to be added

Change the cid:XYZ reference to be something familiar, for example cid:myPhoto
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£ spapUl1.7.1

File Tools Desktop Help

Projects ; | Zf add - Request 1 :
£ B 56_Blobs :
2 X adabasEmployessPhotosSoapBinding =B O = ’http:,I',I'Iocalhost:SGDDD,I'adabas_blobs hd
B add - M
20 =zoapenv: Envelope xmlns:sospenv="http: /S schenas_ xmlsoap. org/soap envelopes" >
~or RIS E =soapenv: Body>
delete <xmid:adabasEnployesesPhotosiddEl ement >
oet <! =-=-Faro or more repoetitions:-->
“ar Request 1 <EmployesPhoto=
list <personnel id=99880000</personnel ids
=2 update <photoType=?</phatoTypas
%2 Request 1 <photo xm:contentType="application/?"*cid:nyPhoto=/phaotax
</EmployeePhotox

“/xmid: adabasEnployeesPhotosiddElenent =

<fzoapenv:Bodys

</soapenv: Envelopes

4

v
Request Propettiss ‘ L SOAP Request L Request Attachments (0} L HTTP Headers (0} |
[

[ Drmmarku I Walie

5. Click the Request Attachments tab, and click Add File

Select the required LOB file and click Open
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<. soapUl 1.7.1

File Tools Desktop Help

- <
Projects ¥ :! add-Request
=B 5G_Blabs "
: = Z0 N . -
= X adabasEmployeesPhokosSoapBinding P =@ 0O L [http'”localhDSt'SSDUDIadabas—bbbs ]
)
B add MNarne | Content bype | Size | Part Tvpe | ConkentID ;

delste
- get
L2 pequest 1

B: lLilsptdate Laak In: [D My Pictures vl @ |§|

Lo-22 Request 1

Marme Size Tvpe | Madified
3 sample Pickures Sharkcut 23/08/05 23:20

: croker.jpg 387 KB JPEG Image 10/08/07 10:43

File Marme: |cr0ker.jpg |

Files of Tyvpe: [AII Files V]

| pen selecked fils |

[ndd file: ] | Remove selected | | Export selected | [@ Online Help ]

-~

| Request Properties | e Request I Request Attachments (0) LHTTP Headers (0) |

When asked to Cache Attachment select No

6. Click the Part column, and select the CID reference you changed earlier, for example myPhoto

2 goapUli.7.1

File Tools Deskkop Help

f ; <[
P%OJ::SBI o ¥| Z! add - Request 1
_Flobs
& T adabasEmplovessrhotossoapinding P = @O [ ] [http:,l',l'Iocthost:SGDDD,I'adabas_blobs ]
5.
‘3 @ odd Mame | Content bype | Size | Part | Type | ConkentID ;

. RF Request1 croker.jpg image/ipeg 397160 ~] ONENGWH
t delete
“e et

e 22 Request 1
+ list:
= g% update

S0 moooia

7. In the Request Properties change Enable MTOM/Inline to true
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Eile  Tools Deskbop  Help
— < .
Prajects ¥| 22 add - Request 1 :
=Bl 5G_Blobs "
: - I0 N
= X adabasEmplovessPhotosSoapBinding P = E O @ |http:filocalhost
=
B asc‘ljd Marne | content type | Siz
i TRl Request 1 croker.jpg image/jpeq 397160
[ delete
B2 oot
I 22 Request 1
lisk
update
L 20 pequest 1
v
Request Properties
Property | Yalue
Mare Request 1
Encoding UTF-&
Endpaint http: /flocalbosk:S60.
Enable MTOM/Inline False -
sernarne Lrue
Password Fal
Domain s [ Add File ] [ Remove selen
WS5-Passward Type [ =oap Request I Request Attachments (1) [
Inline Attachments false
Expand MTOM Attac.., False

8. Click the green arrow to send the request. The server's response will appear in the right pane
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£ coapUl 1.7.1

File Tools Desktop Help

Projects ; ] i add - Request 1
=B} 55_Blobs
& I adsbasEmploveesPhotossoapBinding P = 2O [ ] [http:,l',l'localhost:SGDDD,I'adabas_blohs
E‘@ asdod N|C| Size|Part|T...|C... ; E |<Scnapenv: Envelope xmlns:sec="http://schemas.xmlsoap. orgs/ws;Zl
: ar Request | - nop E “soapeny: Bodys
delets <rsp:operationPesult xnlnz:rsp="http:/fwvww.risaris. com,
“resultsradd successful</results=
“frsp:roperationfesult:
<fsoapenwv:Eody=
= /=oapenv: Envelopes
update
s
Request Properties
Property | Value
Marne Request 1
Encoding UTF-3
Endpoink htep: filocalhost:S60..
Enable MTOM|Inline  true
Lsername
S
WiSS-Password Type PJL L SOAP Response L Response Attachments (0} L HTTP Headers (5) L S5L Info (-} |
Inline Attachments false
Expand MTOM Attac... False response time: 62ms (450 bytes)

9. Now that the record, including the LOB, has been added to your Adabas file, you will want to
retrieve it.

In SOA Gateway LOBs can be retrieved using the get request

Under get, double-click Request 1. Remove the <soapenv:Header> elements as before.

10. Add the personnel_id of the record that you wish to retrieve, for example 99880000.
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£ spapUl 1.7.1

File  Tools Desktop  Help
i : €[
E]ZEE:ZSBI . ¥| :2 get-Reqguest1
obs
: - +_ zo . .
=+ X adabasEmployeesPhotasSoapBinding P =0 E O » [http'-"-'Il':'calh':'s':'56DDD-fadahas—hIDh5
: add
. = |<soapenv:Envelope xmlns:soapenv="http://S/schenas._ xml
Le-22 Request 1 E
delet “=soapenyv: Body:-
; FIELE =xmid: EmployeePhotoGetElenent =
fLLED Request 1 . i
L <personnel id=33220000</personnel id=
get =/xmid: EmployeePhotoGetElenent =
&F Requestl </ soapenv: Bodys
lisk: <fsnapenv: Enwvelopes
update

11. Click the green arrow, and this record will be retrieved from Adabas.
Select the Response Attachments tab, and double-click the attachment.

It should open in a web-browser, or you can save the attachment to disk by selecting Export

selected
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- |olx]

- soapUl 1.7.1

File Tools Desktop Help

Projects ; ] it get - Request 1 ¢ =
=B 55_Blobs
- X adabasEmployessPhotosSoapBinding p=n@OO® [http:J‘,l’localhost:SGDDDfadabas_blobs v] @
B'Z) asdodR - E “zoapenv: Enve]-o‘-; Name ‘ Content bype Size | Part | Type
. ;;Iet:ques <soapenv:Eods 100001 @risaris.com  imagefjpeg 397160 100001 @risaris.com  UMKHOYWH
il o <umid: Emp
i iR Request 1
B get
L322 Request 1
2 list
% update File Edit Yiew Favorites Tools Help

\‘)Back L) @ @ \:h pSearch *Favorites 8 B- hi_;, \_‘J ﬂ \3

Address L@ Ci\Documents and SettingsiBrianLocal Settings\Templresponse-attachment23544, jpeg

~V
Request Properties

Property | Value
Mame Request 1
Encoding UTF-3
Endpaint httpe fflocalhost:560. ..
Enable MTOM/Inline  false
Username
Password
Domain
WS3-Password Tvpe
Inline Attachments False
Expand MTOM Attac... False
Strip whitspaces false
Enable multiparts

Details | Windows

a My Comp

12 You may delete the record, including the LOB, by selecting the delete operation and entering
the corresponding personnel_id.
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9 Accessing LOBs from PHP

LOBs sent as MTOM attachments on a SOAP response from SOA Gateway can be handled by a
PHP program. This, however, requires the presence of the WSO2 Web Services Framework

Provided here are the following sample PHP programs dealing with LOBs access:

= wsf lobsGet: Get a record, save the LOB to a file
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10 Accessing LOBs using a browser

You can also use SOA Gateway to retrieve LOBs from Adabas into a web browser. This can be
any browser of your choice, for example IE running on Windows, retrieving LOBs from Adabas
running on z/OS.

In the tutorial below, we'll use the popular Firefox browser and the SOA Gateway running on
z/OS.

This tutorial assumes you've already got some LOBs stored in your database. See the previous
tutorial to find out how to do this.

1. Start the Control Center and add a new Web Service.

Enter the following information

Name: adabasTutorial_blobs

DataView : Select 'adabas_photoblobs', which is one of the sample definitions delivered with
SOA Gateway

Databaseld: 212 ( or the DBID relevant on your system )
FileNumber: 90

Publish your changes to the server.

2. Start your browser, and enter the following URL
http://soagate:56000/adabasTutorial_blobs? GET&personnel_id=99880000

Replacing soagate:56000 with the hostname and port where SOA Gateway is running.

3. If there is a blob associated with this record, the following is returned
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4. Click on the link "Click here for blob" to display the LOB file in the browser.

File Edit ‘“ew History Bookmarks Tools Help

(\:: - - L:(;"j ﬁ 21t hitpefibmz2:5085/ adabas Tutorial_blobs? GET &personnel_id=29550000

Portus O

<?xml wersion="1.0" encoding="UTF-5" standalone="no™ >
<adsbasEmp loyeesPhotos>

<EmployeePhoto>
<personnel id>99550000</personnel id>
<photoTypervideo/jpeg</photaTypes
<photo isaElob="true":>1</photo>
</EmployeePhotox

</ adshasEmp loyeesPhotos>

Click here for blob

-[;;.v

] Note: The LOB will open automatically in your browser, if it of a MIME type that your

browser understands. Commonly used types are PDE, WMV, JPEG, etc. Refer to your

browser documentation if you need more information.

5. Here you can see a JPEG file opened up in a new tab in firefox after the LOB link was clicked.
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3 adabasTutorial_blobs (JPEG Image, 1280x960 pixels) - Scaled (35%) - Mozilla Firefox
File Edit ‘Wiew History  Bookmarks  Tools  Help

- = L:E‘\'] ﬁ ||_| http:,l',l'ibm2:SDES,I'adabasTut0riaI_bI0bs?GETBLOB&_bIaneF=1&persc| v|

st 904 Gakeway [*| adabasTutorial_blobs {JPEG Ima... (.3

!

RUGBY WORLD CUP 2007 \%’

WY IRISHEUGEY.IE:, o077

Cone
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11 Accessing Adabas through Microsoft InfoPath

This tutorial demonstrates how to invoke operations on an Adabas DataSource exposed as a "Web
service" through SOA Gateway from Microsoft InfoPath.

1. From the InfoPath main menu bar, select File -> Design a Form.

Microsoft Office InfoPath 2003

Fill Dt a Form. ..

Design a Form. ..

open. ..

Close

Save

Save fs..,

Export To

1 C\Documents and Settings\EriantD. .. \updateRecord
2 C\Documents and Settings\Erian’D. . .\deleteRecord
3 C:\Documents and Settings\Brian'Desk. . \getRecord
4 C\Docurments and Settings\BrianiDes. . \liskR.ecord

Exit

%

2. A panel will appear on your right hand side - choose New from Data Connection

This will start a dialog, first select Web Service, click Next
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Accessing Adabas through Microsoft InfoPath

Data Connection Wizard

This wizard helps wou design a form based on the data vou receive from or submit to a Web
service or database,

Select the type of daka connection you wank to use For wour Form:
() Database (Microsoft SOL Server o Microsoft Office Access only)

# Back Mext = l [ Cancel

Select Receive and submit data, click Next
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Accessing Adabas through Microsoft InfoPath

Data Connection Wizard

You can specify how your Form works with the web service, including whether it receives and

submits data ko the service,

Do o wank wour Form ko both receive data From and submit data to the Web service, only ko

submit data, or only to receive data?

{(#) Receive and submit data;

() submit data
i) Receive data

N

X]

[ < Back ][ Mext = l[ Cancel

]

Enter the URL the WSDL for the "Employees" demo file is exposed as: http://soagate:8885/ada-

bas_Employees? WSDL

Click Next

Tutorials
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Accessing Adabas through Microsoft InfoPath

Data Connection Wizard

Weh service dekails (receive data)
Ise these opkions to specify the Web service From which wou receive data.

Enter the location of the Web service wou wank bo use as waour data connection:

Ihttp:,l',l'su:uagate:BBSS,I'adahas_EmpID';.fees?'-.-'-.-'SDL| B ] | [Se_arl:h LCCL...

Example: htkp:f e, contoso, com)Seryice, asmi iSOl

[ < Back ]L__mext} ][ Cancel J

Select the list method, click Next
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Accessing Adabas through Microsoft InfoPath

Data Connection Wizard

The Web service that you selected has the following operations Far providing the ¥ML data
that wour form receives.

Select an operation; Descripkion of operakion:

update
add
delete

ek

[ < Back ]uext:b ,][ Cancel

Assign a name to the response document, click Next
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Data Connection Wizard

Enter a name for the data connection For receiving data;

X

| List Response

\

aunmary

Type: Retrieve data
Web service: http:/fsoagate:8355/adabas [Employees
Cperation: lisk

To set up the data connection For submitting data, dlick Mext,

L «::Eack ,][ hext =

] [ Cancel

Enter the same URL again, click Next
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Accessing Adabas through Microsoft InfoPath

Data Connection Wizand

Web service details (submit data)
Ilse these options to specify the Web service to which wou submit data.

Enter the location of the Web service wou want users to submit their Forms Eo:

|http:,I',l's::nagate:BBBS,I'au:IaI:nas_EmpIn:n':.fees?WSDLl B e | [ Search UDCL... ]

Example: htkp: vy, contoso, com)'Seryvice, asmx WDl

N

[ < Back ]L_ﬂext:: J[ Cancel ]

Choose list and click Next

Tutorials
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Accessing Adabas through Microsoft InfoPath

Data Connection Wizard

ko,

Select an operation:

The ‘Weh service that you selected has the Fallowing operations For submikting wour ¥ML data

Description of operation;

update
add
delete

AN

ﬁEt

A\

| < Back. uext} ][ Zancel

Select "Entire form (XML document....", click Next
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Data Connection Wizard x|
The submit operation For the Web service requires the Fallowing parameters, Specify which
fields ar groups in your Form provide the data For these parameters, IF the Web service
parameter requires an entire XML document, wou can specify thak as well,

Parameters:
Pararneter Tvpe Elermnent:
spersonnel_id skring !
‘name skring
(b skring
Parameter options
Submit the Following data For the selected parameter:
) Field or group: | | =
3
Iniciude: | Texk and child elements only |
{(#)Entire Form (%ML documertt, including processing instruckions:
[ ] submit data as a string
Maoke: Digikally signed daka musk be submitked as a string ko preseryve white spaces,
[ < Back ] Mexk = J [ Cancel
Assign a name to the Send Connection, click Finish
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3.

Data Connection Wizard

Enter a name For the dakta connection For submitting data:

|Emplu:uyees List Request]| A —

SURMmaty

Type: Submit data
Web service: http:/snagate: 3885/adabas_Emplovees
Cperation: lisk

N

< Back L_Einish

][ Cancel J

You will now be presented with a form

66

Tutorials
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B [Design) Templated - Microsoft Office InfoPath 2003
DHk EdE Yew Imet Fomat Jook  Table Help Type 8 question forbel [
() 05 | S pevenrom | f (3 4 0B ¥ 9 0@ | woesen e | @ 8

i A vordana -0 - B 7 uEE==E
: | B8 T - 1

1]

1
4
.iﬁ.
€
v
e

7 Drays Table [ Mo border =l

Click to add a title

lick to add farm content

) 2 4 Data Source
Drag query figlds here ! U iews

= quenFiekds
= |20 2c0:adabasEmployesList Element
8 spersoreel
8 cname
9 ety
Drag data fields here ! 8 depr
1 i 9 b title
= 28 dabaFields
(=1 |8 asgadabasEmployessElemert
1= |8 adahasEmployees

= g} adabasEmployes

P personnelid

F First_name

P middle_name

F name

B mar_stat

L sex

(F ety

F zip

F country

F area_code

F phane

F dept

C B jeb_tive

CF leave_dus

© P leave _kaken =

[ | Shiw details

i Help with the Data Saurca

Do the following:

* Enter a title "List Employees" for example

* Expand the queryFields, drag them to the area "Drag query fields here"

* Expand the dataFields, right-click on the adabasEmployee element. Now drag the adabasEm-
ployee to the area "Drag data fields here", insert it as a Repeating table

At this point, it might make sense to resize the table and the fields in the "repeating table"

[ Rim Query
] 1
Parsonnal Id Flest Name wilddle Name Mar ﬁ Ilp  Country  Area  Phone Dept Job Title Leay Leave
Mame Htat Code 2 Due Taken H
=

4. Once you are happy with how your form looks like, select File -> Preview form -> Default
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) Templated - Microzoft Office InfoPath 2003

i fke | gt Wew Irset Formet Tods  Table

Heb Type

A 19 o |8 0 ] Wspesn et | @) [

| Desunafomn.. wmfpg (3 S
(| PreviewFom v pefauk.. culéshices =
] Chose with Daba ...
i | e | With User Bole...

i ¥ —
List Employees

TClick ta add farm content

. Personnel Id:
: Hame:

L City:

¢ | Dept:

¢ Job Title:

|

‘Personnel Id First Name Middle
i MName

Name Mar Sex City Zip Country Area Phone Dept Job Title Leav Leave .
Stat Code e Due Taken |

You will be presented with a form, enter 4000004* in the Personnel Id field and send the request

to the server
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List Emplovees

Personnel Id: [40000*
Mame:

City

Dept:

Job Title:

6. Your table will now be populated with the data based on your request:

Personnel Id First Name Middle Name Mar Sex City Zip Country Area Phone Dept Job Title Leav Leave
Name Stat Code e Due Taken
40000001 HANS ERIK JENSEN W M KOEBENHAYN 1800 DK 01 215161  ADMA SEKRETAER 30 2s
40000007 CLAUS JESPER JEMNSEN S M MaLBY 2500 DK 01 465800  SYSA PROGRAMMOER 30 13
40000012 NIELS CHRISTIAN HANSEN D M KOEBEMHAYN 1364 DK 01 111122 ADM& REVISOR 30 1S
40000014 KARL SOEREMSEN M M KOEBEMHAYN 2200 DK 01 370252 SYSA PROGRAMMOER 30 18
40000037 JONAS KIM ERIKSSEN S M KOEBENHAYN 1019 DK 01 132526 SY¥YS4 DB-ADMIMISTRATOR =0 20
40000038 ANIT A KARINA ANDERSEM S F  KOEBENHAYN 1850 DK o1 316510 | SALGI SEKRETAER 30 18
40000042 KARSTEN FREDERIKSEN S M S@BORG 2860 DK 01 561519  SYSA SYSTEMCHER o 22
40000043 ELIN GRETE GREGERSEN M F  DDENSE 5000 DK 09 101211  SALGI SAELGER 30 20
40000044  KARIN MARIE ANDERSEN M F  YANLOESE 2720 DK o1 743010 SYSA PROJEKTSEKRETAER 30 19
40000045 HANS OLE MADSEN D M KOEBEMHAYMN 1608 DK o1 038106 MASK QPERATOER -
40000100 HANME IRENE HANSEN M F  MALEY 2500 DK 01 463140 SYSA PROGRAMMOER o 20
40000107 JOHMNY BENTSEN M M BRQEMDEY. STR 2660 DK 0z 541019  MASK QPERATOER o 1z
40000110 PREREM PETERSEN S M HYIDOVRE 2650 DK 01 471719 ADM& EFG-ELEY i 14
40000112 FINN HOLGERSEN Mo M KOEREMHAYMN 2300 DK 01 548959  S¥S5A PROGRAMMOER i 16
40000114 SUSANNE BENTE RASMUSSEN S F  FREDERIKSPERG 2000 DK 01 244950  SYSA SEKRETAER a0 14
40000124 HANS EMIL PETERSEM il M ROEDOYRE 2610 DK 02 910206 SALGI SAELGER an 16
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12 Using Transactions with soapUl

The following tutorial demonstrates how SOA Gateway can be used with Adabas transactions. It
is assumed you are already familiar with the following

® soapUi ( see here )

® Creating SOA Gateway web services from Adabas ( see here )

® Familar with SOAP Header usage concepts ( see here )

For this tutorial, we will use the Employees demo file (usually file number 11) that comes with

Adabas, and the adabas_employees_mini_view data view. It is assumed you have already created
a web service for your Adabas file.

A\  Important: By default, SOA Gateway will time-out and kill existing Conversations after a

period of time. This is can be configured using the Control Centre. with a maximum value
of 3600 (10 minutes). See here for more information.

1. Import the WSDL into soapUi.

2. Choose the request for the add operation, and in the XML set the ConversationState to New
and the TransactionState to New. Also remove the other Header values. Send the request to
SOA Gateway

E.g
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Using Transactions with soapUl

it add - Request 1

o B

P =2 O a [http flocalhost: 56000/ Adabas_Employees

Ta +

(7]

2 |<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsog
25 <soapenv:Header>
<xmid:adabasEmployeeHeaders
<ConversationState>New</ConversationState:>

<TransactionState>New</Transactionitate>
</umid: adahasEmployeeHeader>

</zoapenv:Header>
<soapenv:Body>
<xtid:adabasErployeesiddElement>

<adabhasEmployee>
<personnel id>98000000</personnel id>
<first_namerJoe</first_name>
<name>Murphy</name:
<city>Dublin</eity>
<address_linexl</address linex
<address_linerGreen Street</address_line>
<address_linerRathmines</address_line>
<address_line»Dublin 5</address_line>

</adsbasEmployees
</¥wid: adabasEmployeesAddElement>

</soapenv:Body>
</soapenviEnvelope>

|

ksoapenv:EnveleE xmlns:sec="http://schemas. xmlsoap. org/ws/20
<soapenv:Header>
<xmid:adshasEmployeeHeaders
<Version>l</Version>
<ConversationId>962033611452510072009</Caonversationl
<TransactionId>8978883</TransactionIds>
</xmid:adahasEwployeeHeader>
</soapenv:Header>
<goapenv:Body>
<rap:operationResult xwlns:rsp="http:// wma.risaris. com/
<resultsradd successful</resultss>
</rsp:operationResult:
</soapenviEBody>
</soapenviEnvelope>

HL

|

SOA Gateway has now created a new Conversation and a new Transaction for this request.

The IDs for each of these are returned.

3. Verity that the record has been added successfully, (but not yet committed).

Choose a get request, remote the soapenv:Header element, and enter get the record.

E.g.
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o B

] Z2 get - Request 2
P =@ O [ ] [http:,l’,l’localhost:SSDDD,I’Adabas_Employees

v A

Eiksoapenv:Envelope xmlns: soapenv="http://scl 2 |<soapenv:Envelope xmlns:sec="http://schemas.xmlsoap.org/ws/2Z
< < <soapenv: Body>
<soapenv:Bodys <rap:adsabasEnployeesElement xmlns:rsp="http:/ i, risa
<xmid:adsbasEmployeeGetElement s <adsbasEmployeess
<personnel id>88000000«/personnel id> <adsbasEmployess
</umid: adabasEnployeeGetElement > <personnel id>88000000«/personnel id>
</soapenv:Body> <first name>Toe</first_name>
</soapenv:Envelope> <name>Murphy</name>
<gityrDublin</city>

<address_linex>l</address linex
<address_linexGreen Street</address linex
<address_line>Rathmines</address_linex
<address_line>Dublin S</address_line>
</adabasEmployee>
</adabasEmployees>
</rsp:adabasEmployeesElements>
</soapenv: Body>
</soapenv:Envelope>

KIzzr— G|

L SOAP Request L Request Attachments (0} L HTTP Headers {0} | L SOAP Response L Response Attachments (0} L HTTP Headers (&) L 55L Info {-) |

response time: 24ms (378 bytes) 1:1

The record has been added, but not yet committed. Because Adabas' isolation level is "Read
Uncommitted" (also known as "dirty read"), a request from a non-conversational request will
still return the added, but-yet-uncommitted, record.

4. Now backout the transaction.

Choose a get request, and enter the following:

" ConversationState to End

® ConversationID to the value returned in the add response
" TransactionState to Backout

® TransactionlID to the value returned in the add response

E.g
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zo
aF

get - Request 1

o B

»

=i @O [ ] [http:,l’,l’localhost:56000,|’Adabas_Employees

-

)

=
=
=

<soapenv:Envelope xmlns:soapenv="http://schemas.xmls
<soapenv:Header:>

<xmid:adabasEmployeseHeaders
<ConversationState>End</ConversationState>
<ConversationId>962033611452510072009</ Cony|
<TransactionState>Backout</TransactionState
<Transactionld>9976864karansactionId>

</xmid:adabasEnployeeHeader>

</soapenv:Header>
<soapenv: Body:>
<xmid:adabasEmployeeGetElement >
<personnel id>88000000«/personnel id>
</xmid:adabasEmployeetetElement>
</soapenv:Body>
</soapenv:Envelope>

2 [«<soapenv:Envelope xmlns:sec="http://schemas.xmlsoap.org

<soapenv:Headers
<xmid:adsbasEmployeseHeaders>
<Versionrl</Version>
</xmid:adsbhasEnp loyeeHeaders>
</soapenv:Header>
<soapenv:Bodys

<adsbasEmployeesss
<adsbasEmp loyees

<first namerJoe</first_names>
<name>Mur phy</ name>
<gity>Dublin</city>
<address_linexl</address_line>

</adabasEmployees
</adabasEmployees>
</rsp:adabasEmployeesElement>
</soapenv:Body>
</soapenv:Envelope>

<rap:adshasEuployeesElement wmlns:rsp="http:// wnm

<personnel id>38000000</personnel ids

<address_linexGreen Street</address_line]

<address_line>Rathmines</address_linex>
<address_line>Dublin 5</address linex

L SOAP Request L Request Attachments (0} L HTTP Headers (0} |

response kime: 10ms (1023 bytes)

L SOAP Response L Response Attachments (0} IUTTP Headers (6)L 55L Info -3 |

5. Now, if you re-run the request from Step 3, the item does not exist as the previous add has been
backed out.

E.g.

zo
aF

get - Request 2

o B

»

= @O [ ] [http:,l’,l’localhost:SSDDD,I’Adabas_Employees

7]

)

o
d
x

<

ksoapenv:Envelee xmlns: soapenv="http: /|3 2 |<soap:Envelope xmlns:soap="http://schemas.xmlsoap.ory/soap/envelope/
x
<soap:Bodys

<soapenv:Bodys <soap:Faults>

<xmid:adsbasEmployeeGetElement s
<personnel id>88000000«/person

<goap: faultcode>—-31009</s0ap: faultcode>
<soap:faultstring:

</xmid: adshasEnployeetetElement > Fri Jul 10 11:51:23.00359390, pid: 00001032, tid: 00001336,
</soapenv:Body> ERROR: in file .%\vw00lisrchadabasDriver.cpp, at line Z584.

</soapenv:Envelope>

Tzl G|

adsbasDriver: :getData(] returned -31009, indicating
the requested record/item does not exist.

</soap: faultstring>
</soap:Fault>
</soap:Body>
<fsoap:Envelee4

|
L SOAP Request L Request Attachments (0} L HTTP Headers {0} |

L SOAP Response L Response Attachments (0} L HTTP Headers (&) L 55L Info {-) |

response time: 24ms (471 bytes)

15: 17
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13 SOA Gateway - Configuration Versioning with Eclipse and

CVS
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SOA Gateway - Configuration Versioning with Eclipse and CVS

Introduction

If Eclipse is used as the management interface to SOA Gateway then versioning of the ASG con-
figuration files can be achieved easily with CVS. Eclipse provides CVS interfaces, so much of the
following will be familiar to many users of Eclipse already.

Using CVS can also bring advantages including security, auditing control, redeployment facilitation
and metadata management.

Requirements

In order to take advantage of this option, you must have available :

® aserver running CVS and to which you have access

® a CVS 'module’ where you can add the ASG related files you wish to maintain

Example Setup

= CVS Server Details

= CVS Module Selection

= Selecting a Location in Eclipse

= Adding Files to CVS

= Making CVS aware of file changes

Select File->Import from the Eclipse Menus and then choose "Checkout Projects from CVS".
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SOA Gateway - Configuration Versioning with Eclipse and CVS

| & Java - Eclipse SDK

File Edit Refactor Source Navigate Search Project Run Window Help
ETRSY = [#ava
14 Select Qutline 22 =g

N
p} Amrm i
h outline is not
Import a project from a CVS Repository. H —

Select an import source:

- ADABAS SOA Gateway Configuration

«: ADABAS SOA Gateway Resource Definition
T, Archive file

9 Existing Projects into Workspace
LiExternal Features

< External Plug-ins and Fragments
[, File system

ElPreferences

s, Team Project Set

| | wees |

[ Cancel ]

& Problems 2 Javadoc| Declaration
0 errors, 0 warnings, 0 infos

| Description | Resourct | In Folder | Location

CVS Server Details

Enter the details required for your CVS server.
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SOA Gateway - Configuration Versioning with Eclipse and CVS

& Checkout from CVS —

Enter Repository Location Information

%E-\
=
L

Define the location and protocol required to connect with an existing CVS
repository.

-Location

Host: [wsserver

Repository path: [fhomefcvs/repositoryl 37

-Authentication

User: [cvsuser

UG | EJE

Password: [*******************

-Connection

K

Connection type: [pserver
® Use default port
) Use port: [

[J Save password

/I, Saved passwords are stored on your computer in a file that is difficult, but not
impossible, for an intruder to read.

< Back l Next > Cancel

CVS Module Selection

Enter the name of the CVS module where you are to keep your ASG files, or select the module
from a list.
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SOA Gateway - Configuration Versioning with Eclipse and CVS

© Checkout from CVS =&

Select Module cvs
e
Select the module to be checked out from CVS

® Use specified module name: |AsgServer102| |

() Use an existing module (this will allow you to browse the modules in the repository)

<Back | Next> || Finish || Cancel

Selecting a Location in Eclipse

Select where you wish to check out the CVS module to. You may place it in various locations. If
you use an existing Eclipse project, the module will appear as a folder within it. This example
creates a new Simple Project.
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SOA Gateway - Configuration Versioning with Eclipse and CVS

& Check Out As —

Check Out As
Select the method of check out

Choose how to check out folder 'AsgServer102'
® Check out as a project configured using the New Project Wizard

0 Check out as a project in the workspace

Project Name:

() Check out into an existing project

<Back | Next> || Einish ||

Cancel
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SOA Gateway - Configuration Versioning with Eclipse and CVS

=

& New Project =

Select a wizard [—-\’?’

Create a new project resource e

Wizards:

b =C++

b =CVS

b =Eclipse Modeling Framework
b =Java

b =Plug-in Development

= [=Simple

Next > | [ ] l Cancel

<Back | Next> || Finish || cancel
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SOA Gateway - Configuration Versioning with Eclipse and CVS

D heck U AS O X
New Project )

Project B
Create a new project resource. I

Project name: [asgTest] |

Project contents
% Use default

|

< Back Finish ] [ Cancel

< Back l Next = ] [ Finish l [ Cancel

The New Project is now shown in the Eclipse Package Explorer Window, the icon denoting it as
a CVSitem, and the server name shown at the end.
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SOA Gateway - Configuration Versioning with Eclipse and CVS

& Java - Eclipse SDK

File Edit Refactor Source Navigate Search Project Run Window Help
| ca- |0 @r | EH G | ® 7|0 v eror & & Java
i Package Expl... x =B = B gz Qutline 2 =8
o @ & = (= An outline is not
» 5 >asgTest [cvsserver] available.
[Z/ Problems &2 Javadoc|DecIaratiDn| X & ¥ 0O
0 errors, 0 warnings, 0 infos
Description | Resourl:|| In Folder Location
] asgTest el
When you import items from ASG, you can now save them in this Project.
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SOA Gateway - Configuration Versioning with Eclipse and CVS

< Java - Eclipse SDK - 0 x
File Edit Refactor
= 3 o x
|- @ & |%- 0 = [§3aval
——— | ADABAS SOA Gateway Configuration Import . =
8 utline 2 ]
@ w @ Please select a valid Destination Folder Wi 5 mEt
v B >asgTest [cvg e
Host/IP: [asgServerlDZ I
Destination [? HBers‘]
Folder Selection {—;‘
Select container to import SOA configuration to
& e D
& >asgTest [cvsserver]
[ Cancel
[ | asgTest OK | [ Cancel @]
I
Adding Files to CVS

Note that your imported files will need to be explicitly added to the CVS repository. Also note

that you will have to select the file type when adding it to CVS. This would normally be ASCII
TEXT and not the default of Binary.
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SOA Gateway - Configuration Versioning with Eclipse and CVS

& Java - Eclipse SDK
File Edit Refactor Source Navigate Search Project Run Window Help

| e~ P Q- Qr | E HE | @O e e o gg
&1 P =8 = O || gz Outline = =0

& DB BEE T An outline is not
available.

~ g >asgTest [cvsserver]

Bfi>asgServer102_80.xme

New 3

Open F3
Open With 3

= Copy Ctrl+C
[ Paste Ctri+V
% Delete Delete
Build Path ’
Refactor Shift+Alt+T »

Synchronize with Repository

Import... Commit...
Export...

% |G B

Refresh F5 Create Patch...

Run As R Apply Patch...

Debug As 3

%
v
Compare With vk
Replace With 3

Properties Alt+Enter ?
Open As 4
Add to Version Control

Add to .cvsignore...
[«] | ED)]

[ } asgServer102_80.xmc - asgTest @1

Making CVS aware of file changes

Every time you make a change to your ASG related files, you should commit those changes to the
CVS repository.
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SOA Gateway - Configuration Versioning with Eclipse and CVS

& Java - Eclipse SDK =

| ci-

|#s> OrQr | & # G- |® 7| @ | % & 5

File Edit Refactor Source Navigate Search Project Run Window Help

- [

4

53 2 O

@ § BE Y

= . >asgTest [cvsserver]

Bl >asgServer102_80.xmc

(%]
&

New

Open
Open With

= Copy
[ Paste
¥ Delete

Build Path
Refactor

e [mport...

Export...
Refresh

Run As
Debug As

==

Compare With
Replace With

Properties

Open As

4

[P

»

Ctrl+C
Ctri+V

Delete
»

Shift+Alt+T »

E5

s

4

Alt+Enter

3

< )

E

] asgServer102_80.xmc - asgTest

g= Outline =2
An outline is not
available.

=08

Create Patch...
Apply Patch...
L]
¥ Branch...
4R Merge...

Synchronize with Repository

T * ¢ - ©

[E—

]

«

A useful comment should be added during the commit describing the change(s) made. Ticket Id's
and other related information can be added here also.
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SOA Gateway - Configuration Versioning with Eclipse and CVS

&= Commit Files =

Commit |

Enter a comment for the commit operation. LCVs|

the "Employees" file on the test DB.|

Changes made to the Adabas SOA Gateway configuration. Added information for D

<Choose a previously entered comment>

Changes = &

- = asgTest [cvsserver]
“.rasgServer102_80.xmc (ASCII -kkv)

Finish ] l Cancel

That should cover the basics required to use Eclipse in conjunction with CVS so that changes to
your ASG configuration files are more controlled. Further information on the use of CVS with
Eclipse, and how acquire and set-up a CVS server, can be found at the external sites listed below.

More Information

More information related to CVS can be found at http://www.nongnu.org/cvs/

More information related to CVS use with Eclipse can be found in the Eclipse documentation at
http://www.eclipse.org/
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14 Tut_02_List.java

import SoaG.*;
import SoaG.AdabasEmployeesMiniServiceStub.*;

~
*

The SOA Gateway LIST method will return all data matching the
criteria at once, no matter how Targe the result set is.

So if you need (or want) to retrieve the result set in "chunks"
of records, or your request requires complex search syntax,
use the SELECT method.

Tut_03c_SelectConversational.java provides an example for this.

B T T

/
public class Tut_02_List {
public static void main(Stringl] args) {

try {
AdabasEmployeesMiniServiceStub stub = new AdabasEmployeesMiniServiceStub();

AdabasEmployeeKeyType keys = new AdabasEmployeeKeyType();
keys.setPersonnel_id("50005*");

AdabasEmployeelistElement TistKey = new AdabasEmployeelistElement();
listKey.setAdabasEmployeelistElement(keys);

AdabasEmployeesMiniElement result = null;
result = stub.list(listKey, null, null);
AdabasEmployeesMiniElementType root = result.getAdabasEmployeesMiniElement();

AdabasEmployeesMiniType group = root.getAdabasEmployeesMini();
AdabasEmployeeType elementsl[] group.getAdabasEmployee();
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Tut_02_List.java

System.out.printin("Number of record read: " + elements.length);

for (int i = 0; i < elements.length; i++) {
AdabasEmployeeType r = elements[il;
System.out.printin("Record [" + i + "]1"
+ "Personnel Id=" + r.getPersonnel_id() + ",

+ "Name=" + r.getName() + ",
+ "First Name=" + r.getFirst_name() + ", "
+ "City=" + r.getCity());

} catch (Exception ex) f{
ex.printStackTrace();
}

90
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15 ex01_SoaGatewayFirst.php

<?php
/*
* This set of examples demonstrate the simplicity in accessing Adabas
* data as "WebServices" from PHP, based on the "EmployeesMini" view
* representing a subset ("View") of the Adabas demo file "Employees".
*
* This first example outlines the usage of the PHP SoapClient class,
* which provides the infrastructure for issuing SOAP requests.
*
* A1l examples are based on an Adabas SOA Gateway server running on
* host "soagate", port 8082, these need to be adjusted to the actual
* server host/port used at your site.
*
=
/*
* Instantiate the PHP "SoapClient" class
)
try |
/~k
*

*

*/

The only required parameter when instantiating "SoapClient" is the URL
pointing to the WSDL for the WebService to be accessed.

$soapclient = new SoapClient("http://lTocalhost:8022/adabas_EmployeesMini?WSDL") ;
} catch (SoapFault $soapfault) f{

/*

* In case of a SOAPFault being thrown, this will be caught and the fault

S

information printed. If a SOAPFault occurs outside of a "try/catch"
structure, PHP will abend the script with a generic message.

Here we print the SOAPFault information in a structured way, the "<pre>"
tags are required to format the object nicely.

N



ex01_SoaGatewayFirst.php

echo "<pre>";
print_r($soapfault);
echo "</pre>";
return;

}

/*

* Without any knowledge of, or looking at Adabas definitions, a "WebService <

programmer"

* can easily retrieve the signature of any exposed Adabas SOA Gateway Service and
code based on it.

*
*
* First we use a method of the SoapClient class to retrieve the functions exposed
* by the specific "WebService", and print it:

=/

echo "<pre><B>Functions:</B>\n\n";

print_r($soapclient->__getFunctions());

/*

* The function prototypes shown by the __getFunction() method also depict the <
required

* parameters and the return values. Their definitions can be printed as well:

=/

echo <

NAN====ccccccccccccssssscsocaccooooooooooooccccsoososso0000000as00000: \n\n<B>Type <«
Definitions:</B>\n\n";

print_r($soapclient->__getTypes());

echo "</pre>";

/*
* Proceed to ex02_SoaGatewayEmplList.php - List and format Employees data
=/

2>
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16 ex02_SoaGatewayEmpList.php

<?php

/*

* This example demonstrates usage of the "list" function exposed by any

* Adabas SOA Gateway "WebService" from PHP, retrieving selected records

* from the Adabas demo file "Employees", and formatting it, in 4 easy steps.
)

/*

* Step 1: Instantiate the PHP "SoapClient" class

&/
try {

$soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL");
} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}
/*

* Step 2: Build the key ("descriptor") array, due to parser requirements ALL
2 key elements need to be specified, but elements may be Teft empty

= when unused.

)

$1istkey = array(
"personnel_id' => '",
"first_name' => "',
"name' => '",
'city' => 'CI*');

/*
Step 3: Execute the "Tist" request, passing the key array as the only parameter,
% the response object will consist of an "adabasEmployees" element containing
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ex02_SoaGatewayEmpList.php

B an array of "adabasEmployee" elements.
=/
try {

$1istresponse = $soapclient->Tist($listkey);
} catch (SoapFault $soapfault) {

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}

/*
* Step 4: Format the Employee records nicely into a HTML table.
%

echo "<table border=1 cellpadding=5>";
echo "<tr><th>Personnel Id</th><th>Name</th><th>First Name</th><th>City</th><th «
width=200>Address Line</td>";

/*

* Loop through all "adabasEmployee" elements, creating a table row for every <
single one

=)

if ( isset($listresponse->adabaskmployees->adabasEmployee) )
{

$Employees = $1istresponse->adabaskEmployees->adabaskmployee;
if (lis_array($Employees))

$Employees = $listresponse->adabasEmployees;

foreach ($Employees as $Employee) {

echo "<tr><td>$Employee->personnel_id</td><td>$Employee->name</td><td>",
"$Employee->first_name</td><td>$Employee->city</td><td>";

echo "<table>";

/*
* Format the "address_line" element (a MU(Ttiple value field)) as a table within «
the table
=
if (lis_array($Employee->address_line)) ({
echo "<tr><td width=200>$Employee->address_Tine</td></tr>";
} else |
foreach ($Employee->address_line as $addr) ({
echo "<tr><td width=200>%$addr</td></tr>";
}
}
echo "</table>";
echo "</td></tr>";
}
}
/*
* Proceed to ex03_SoaGatewayEmpAdd.php - Add a new employee record
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ex02_SoaGatewayEmpList.php

*/
7>
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17 ex02a_SoaGatewayEmpListDescending.php

<?php

/*

* This example demonstrates usage of the "list" function exposed by any

* Adabas SOA Gateway "WebService" from PHP, retrieving selected records

* from the Adabas demo file "Employees", and formatting it, in 4 easy steps.
)

/*

* Step 1: Instantiate the PHP "SoapClient" class

&/
try {

$soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL");
} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}
/*

* Step 2: Build the key ("descriptor") array, due to parser requirements ALL
2 key elements need to be specified, but elements may be Teft empty

= when unused.

)

$1istkey = array(
"personnel_id"' => '50005*",

'"first_name' => ,

'name' => "',
"city' => '');
/*
Step 3: Execute the "Tist" request, passing the key array as the only parameter,
% the response object will consist of an "adabasEmployees" element containing
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ex02a_SoaGatewayEmpListDescending.php

B an array of "adabasEmployee" elements.
=/
try {

$1istresponse = $soapclient->Tist($listkey);
} catch (SoapFault $soapfault) {

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}

echo "List of Employees by personnel id - Ascending<br><br>";
formatResponse($listresponse);

/*
Step 4: Build the SOAP Header structure to trigger a DESCENDING
read instead of an ascending one.
=

$headers = array(
'SOAGateway_Internal_Adabas_Read_Direction' => "Descending"
)

$header = new SoapHeader("http://www.risaris.com/namespaces/xmiddle",
"adabaskEmployeeHeader",

$headers, false);

$soapclient->__setSoapHeaders(array($header));

/*

* Step 5: Execute the "list" request, passing the key array as the only parameter,
2 the response object will consist of an "adabasEmployees"™ element containing
B an array of "adabasEmployee" elements.

=)

try {

$1istresponse = $soapclient->1ist($listkey);
} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}

echo "<br><hr><pr>List of Employees by personnel id - Descending<br><br>";
formatResponse($listresponse);

/*

* Sub: Format the Employee records nicely into a HTML table.
=

function formatResponse($listresponse){

echo "<table border=1 cellpadding=5>";
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ex02a_SoaGatewayEmpListDescending.php

echo "<tr><th>Personnel Id</th><{th>Name</th><th>First Name</th><th>City</th><{th «
width=200>Address Line</td>";

/~k

* Loop through all "adabasEmployee" elements, creating a table row for every <
single one

R/
if ( isset($listresponse->adabasEmployees->adabasEmployee) )
{

$Employees = $1istresponse->adabasEmployees->adabasEmployee;

if (lis_array($Employees))

$Employees = $listresponse->adabasEmployees;

foreach ($Employees as $Employee) ({
echo «
"<Er<td>$Emplayee->personnel_id</td><td>$Emplayee->name</td><td>$Empl oyee->first, name</td><td>$Emplayee->city</td<td>";

echo "<table>";

if (lis_array($Employee->address_Tline)) ({
echo "<tr><td width=200>$Employee->address_Tine</td></tr>";
} else |
foreach ($Employee->address_line as $addr) ({
echo "<tr><td width=200>%$addr</td></tr>";
}
}
echo "</table>";
echo "</td></tr>";
}

}

echo "</table>";

}

/*

* Proceed to ex03_SoaGatewayEmpAdd.php - Add a new employee record
=/

7>
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18 ex02a_SoaGatewayEmpListSorted.php

<?php

/*

* This example demonstrates usage of the "list" function exposed by any

* Adabas SOA Gateway "WebService" from PHP, retrieving selected records

* from the Adabas demo file "Employees", and formatting it, in 4 easy steps.
)

/*

* Step 1: Instantiate the PHP "SoapClient" class

&/
try {

$soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL");
} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}
/*

* Step 2: Build the key ("descriptor") array, due to parser requirements ALL
2 key elements need to be specified, but elements may be Teft empty

= when unused.

)

$1istkey = array(
"personnel_id"' => '50005*",

'"first_name' => ,

'name' => "',
"city' => '');
/*
Step 3: Execute the "Tist" request, passing the key array as the only parameter,
% the response object will consist of an "adabasEmployees" element containing
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ex02a_SoaGatewayEmpListSorted.php

B an array of "adabasEmployee" elements.
=/
try {

$1istresponse = $soapclient->Tist($listkey);
} catch (SoapFault $soapfault) {

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}

echo "List of Employees by personnel id = 50005* - Default sort order<br><br>";
formatResponse($listresponse);

/*
Step 4: Build the SOAP Header structure to trigger a DESCENDING
read instead of an ascending one.
=

$headers = array(
'SOAGateway_Internal_Adabas_Sort_Order' => "city"
)

$header = new SoapHeader("http://www.risaris.com/namespaces/xmiddle",
"adabaskEmployeeHeader",

$headers, false);

$soapclient->__setSoapHeaders(array($header));

/*

* Step 5: Execute the "list" request, passing the key array as the only parameter,
2 the response object will consist of an "adabasEmployees"™ element containing
B an array of "adabasEmployee" elements.

=)

try {

$1istresponse = $soapclient->1ist($listkey);
} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}

echo "<br><hr><pbr>List of Employees by personnel id = 50005* - now sorted by <
City<br><br>";
formatResponse($listresponse);

/*

* Sub: Format the Employee records nicely into a HTML table.
=

function formatResponse($listresponse){
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echo "<table border=1 cellpadding=5>";
echo "<tr><th>Personnel Id</th><th>Name</th><th>First Name</th><th>City</th><th <«
width=200>Address Line</td>";

/*
* Loop through all "adabasEmployee" elements, creating a table row for every <
single one
*f
if ( isset($listresponse->adabaskmployees->adabaskEmployee) )
{
$Employees = $listresponse->adabasEmployees->adabasEmployee;
if (lis_array($Employees))
$Employees = $listresponse->adabasEmployees;

foreach ($Employees as $Employee) {
echo <
"<tr<td>$Employee->personnel_id</td><td>$Emplayee->name</td><td>$Empl oyee->first,_name</td><td>$Employee->city</td><td";

echo "<table>";

if (lis_array($Employee->address_line)) f{
echo "<tr><td width=200>$Employee->address_Tine</td></tr>";
} else {
foreach ($Employee->address_line as $addr) ({
echo "<tr><td width=200>$addr</td></tr>";
}
}
echo "</table>";
echo "</td></tr>";
}

}

echo "</table>";

}

/*

* Proceed to ex03_SoaGatewayEmpAdd.php - Add a new employee record
*/

7>
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19 ex06_SoaGatewaySpecial_SubDescriptor.php

<?php

/*

* This example demonstrates usage of the "list" function exposed by any

* Adabas SOA Gateway "WebService" from PHP, retrieving selected records

* from the Adabas demo file "Employees", and formatting it, in 4 easy steps.
)

/*

* Step 1: Instantiate the PHP "SoapClient" class

&/
try {

$soapclient = new SoapClient("http://localhost:8022/adabas_Employees_special?WSDL");
} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}
/*

* Step 2: Build the key ("descriptor") array, due to parser requirements ALL
2 key elements need to be specified, but elements may be Teft empty

W when unused. Here we are using the SUB-descriptor "department".

=/

$1istkey = array(
"personnel_id' => "",

"first_name' => "7,

"name’ =» "
'"birthday" =» 77
"city' => "",
"dept'=> "",

"job_title’ => "y

'lTanguage_spoken'=>"",
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"leave_left' => "",

"dept_person' = "7

'currency_salary'=> "",

"department’ => array('dept' => "MGMT"),

'phonetic_name' => "");
/*
* Step 3: Execute the "list" request, passing the key array as the only parameter,
B the response object will consist of an "adabasEmployees" element containing
# an array of "adabasEmployee" elements.
&y
try |

$listresponse = $soapclient->1ist($1istkey);
} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}

/*
* Step 4: Format the Employee records nicely into a HTML table.
=/

echo "Find all Employees in department group \"MGMT\" - using an Adabas <
SUB-Descriptor<br><br>";

echo "<table border=1 cellpadding=5>";

echo "<tr><th>Personnel Id</th><th>Name</th><th>First «
Name</th><th>City</th><th>Department</td>";

/*

* Loop through all "adabasEmployee" elements, creating a table row for every <
single one

=/

foreach ($1istresponse->adabasDemoEmployeesSpecial->demoEmployeeSpecial as $Employee) <
{

echo "<tr><td>$Employee->personnel_id</td><td>$Employee->name</td><td>",

"$Employee->first_name</td><td>$Employee->city</td><td>$Employee->department_code</td>";

echo "</td></tr>";
}

/*
* Proceed to ex03_SoaGatewayEmpAdd.php - Add a new employee record
&/
7>
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<?php

/*

* This example demonstrates usage of the "list" function exposed by any

* Adabas SOA Gateway "WebService" from PHP, retrieving selected records

* from the Adabas demo file "Employees", and formatting it, in 4 easy steps.
)

/*

* Step 1: Instantiate the PHP "SoapClient" class

&/

try {

$soapclient = new SoapClient("http://localhost:8022/adabas_Employees_special?WSDL");
} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}
/*

* Step 2: Build the key ("descriptor") array, due to parser requirements ALL
2 key elements need to be specified, but elements may be Teft empty

W when unused. Here we are using the SUB-descriptor "department".

=/

$1istkey = array(
"personnel_id' => "",
"first_name' => "",

"name’ =» "
'birthday' => "",
"city' => "",
"dept'=> "",

"job_title' =>"",
'lTanguage_spoken'=>"",
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"lTeave_left' => "",

"dept_person' => array('dept' => "MGMT10", 'name' => "K*"),
"currency_salary'=> "",

"department' => "",

"phonetic_name' => "");

/*

* Step 3: Execute the "list" request, passing the key array as the only parameter,
B the response object will consist of an "adabasEmployees" element containing
# an array of "adabasEmployee" elements.

&y

try |

$listresponse = $soapclient->1ist($1istkey);
} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}

/*
* Step 4: Format the Employee records nicely into a HTML table.
=/

echo "Find all Employees in department group "MGMT10' whose names start with 'K' - <
using an Adabas SUPER-Descriptor<br><br>";

echo "<table border=1 cellpadding=5>";

echo "<tr><th>Personnel Id</th><th>Name</th><th>First <
Name</th><th>City</th><th>Department</td>";

/*

* Loop through all "adabasEmployee" elements, creating a table row for every <
single one

=/

foreach ($1istresponse->adabasDemoEmployeesSpecial->demoEmployeeSpecial as $Employee) <
{

echo "<tr><td>$Employee->personnel_id</td><td>$Employee->name</td><td>",

"$Employee->first_name</td><td>$Employee->city</td><td>$Employee->department_code</td>";

echo "</td></tr>";
}

/*
* Proceed to ex03_SoaGatewayEmpAdd.php - Add a new employee record
&/
7>
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<?php

/*
* We now add a new Employee record, which is just as simple.
&y

tryd

$soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL");
} catch (SoapFault $soapfault) f{

printSoapFault($soapclient, $soapfault);

return;

}

/*

* Constructing the "data record" is similar to building the key array
* for a "list" operation, MUs are represented by an array within the
* o array.

)
$adabasEmployee = array (

"personnel_id' => '99999999"',

"first_name' => 'Kirk',

"name’ => 'Newlyadded',

"city' => 'City"',

"address_1line' => array ('route 66', 'from here', 'to there', 'CA'")
)
/*

* The expected structure is equivalent to the one returned by "list",
* thus we need to create an array of "adabasEmployee" elements, even
* though there is just one:

)

$adabasEmployees = array($adabasEmployee);

/*
* Now add the Employee
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=/
try {

$Adabasresponse = $soapclient->add($adabasEmployees);
} catch (SoapFault $soapfault) f{
printSoapFault($soapclient, $soapfault);

return;

}

/*

* An "add" results in a "short response", print the message:
=/

echo "<pre>result: $Adabasresponse->results</pre>";
/*

* The SOAPFault is handled in a function:

%Y

function printSoapFault ($soapclient, $soapfault) f{
echo "<pre>";

echo "\n\nSoap Fault occurred\n\nFaultCode..: <

".$soapfault->faultcode."\nFaultString: ".$soapfault->faultstring;
echo "</pre>";
}

/*

* Proceed to ex04_SoaGatewayEmpGet.php - Get and display the newlyadded employee <«
record

%Y

2>
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<?php

/*

* The "get" operation is even easier.
&/
tryf

$soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL", <«
array('trace' => 1));

} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

}

/*

* Construct the "key array", which consists of just one element,
* the primary key for the employees file - "personnel_id";

)

$primKey = array('personnel_id' => "99999999");

/*

* Get the record

&y
try {

$Adabasresponse = $soapclient->get($primKey);
} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}

/*
* Check if we actually got the record we are looking for
=
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if (is_null($Adabasresponse->adabaskmployees->adabastEmployee)) {
echo "No Employee with personnel_id=".$primKey[ 'personnel_id'];
return;

}

/*

* Print the formatted response
&/

echo "<pre>";

print_r($Adabasresponse);
echo "</pre>";

/*

* Proceed to ex05_SoaGatewayEmpDel.php - Delete the record added in <«
ex03_SoaGatewayEmpAdd.php

%Y

7>
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<?php

/*
* Finally we delete the Employee record with personnel_id=99999999 again
&y

tryd

$soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL", <
array('trace' => 1));

} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

}

/*

* A1l we need is the primary key

)

$primKey = array('personnel_id' => "99999999");

/*

* Delete takes the key as the input and returns a "short response" (just a message)
%Y
try {

$Adabasresponse = $soapclient->delete($primKey);
} catch (SoapFault $soapfault) f{

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}

/*
* Print the response
=/
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echo "<pre>";
print_r($Adabasresponse);
echo "</pre>";

?>
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<?php

/*

* 0n entry to the form determine if the "List Employees" button has been pressed,
* if this is the case, retrieve the form field values.
&y

if (isset($_POST['submit'])) {

$Fname = $_POST["Fname"];

$Lname = $_POST["Lname"];

$Persid $_POST["Persid"];

$City $_POST["City"1;

;>
<html>
<head>
<title>Personnel Info</title>
</head>
<body>
{font face="courier">
<form method="post" action="<?php echo $PHP_SELF;?>">

Personnel Id: <input type="text" size="8" maxlength="8" name="Persid" value="<? «
echo $Persid; ?2>"><br />
First Name..: <input type="text" size="20" maxlength="20" name="Fname" value="<?
echo $Fname; ?2>"><br />
Last Name...: <input type="text" size="20" maxlength="20" name="Lname" value="<? «
echo $Lname; ?2>"><br />
City........: <input type="text" size="20" maxlength="20" name="City" value="<? «

echo $City; ?>"><br />

<br/>

<input type="submit" value="List Employees" name="submit">

</form>

<?

/*

* If the "List Employees" button has been pressed, retrieve the Employees record(s) <«
and format
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* them into a HTML table. The code used here is, with the exception of the <
variables used for

* building the keys array, equivalent to ex02_SoaGatewayEmplList.php

=/

if (isset($_POST['submit'])) {

echo "Selected: Personnel Id=''".$Persid."'', <
first_name=""'".$Fname."'"' ,Name="'"".$Lname;
echo "'', City=""".$City.""''<br/><br/>";

$soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL");

$key = array(
"personnel_id' => $Persid,

"first_name' => $Fname,
"name’ => $Lname,
"city' => $City

)
$result = $soapclient->Tist($key);

echo "<table border=1 cellpadding=5>";
echo "<tr><th>Personnel Id</th><th>Name</th><th>first Name</th><{th>City</td><td «
width=200>Address</td></tr>";

if ( isset($result->adabasEmployees->adabasEmployee) )
{

$Employees = $result->adabaskEmployees->adabasEmployee;
if (lis_array($Employees))

$Employees = $result->adabasEmployees;

foreach ($Employees as $Employee) {
echo <

"<Er<Xtd>$Employee->personnel _id</td><td>$Empl ayee->name</ td><td>$mplayee->first,_name</td><td>$hmplayee->city</td<td>";
echo "<table>";

if (!is_array($Employee->address_Tline)) ({
echo "<tr><td width=200>$Employee->address_Tine</td></tr>";
} else {
foreach ($Employee->address_line as $addr) ({
echo "<tr><td width=200>$%$addr</td></tr>";
}
}
echo "</table>";
echo "</td></tr>";
}

}

echo "</table>";
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</body></html>
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25 ex15_SoaGatewayUpdateForm.php

<?php

/*

This form incorporates ALL Adabas SOA Gateway access methods,
list, get, add, update, delete

and demonstrates how easily web applications can be implemented
based on the Adabas SOA Gateway

*
*
*
*
*
*

/
global $PHP_SELF;

$Persid = "";
$Fname = "";
$Lname =
$City = "";

$Addr[0] = "";
$Addr[1] "
$Addr[2] "
$Addr[3] = "";
$msg = "";

if (isset($_POST['submit']l)) {

if ($_POST['submit'] != "Reset") f{
$Fname = $_POST["Fname"];

$Lname = $_POST["Lname"];
$Persid = $_POST["Persid"];

$City = $_POST["City"1;

$Addr = $_POST["Addr"1;

try {
$soapclient = new SoapClient(
"http://localhost:8022/adabas_EmployeesMini?WSDL");
} catch (SoapFault $soapfault) {
echo "<pre>";
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print_r($soapfault);
echo "</pre>";
return;

if ($_POST['submit'] == "Delete") {

try |

$Adabasresponse = $soapclient->delete(array('personnel_id"' => $Persid));
} catch (SoapFault $soapfault) ({

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}
$msg = $Adabasresponse->results;
}

if ($_POSTL'submit']l == "Get") {

try {

$Adabasresponse = $soapclient->get(array('personnel_id"' => $Persid));
} catch (SoapFault $soapfault) ({

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}

if (lisset($Adabasresponse->adabasEmployees->adabasEmployee)) {
$msg = "No Employee with personnel_id=".$Persid;

$Lname = "";

$Fname = "";

$City = "";

$Addr = array("", "", "", "");

} else {

$Employee = $Adabasresponse->adabasEmployees->adabasEmployee;

$Persid = $Employee->personnel_id;
$Lname = $Employee->name;

$Fname $Employee->first_name;
$City = $Employee->city;

$Addr = $Employee->address_line;

}

}

if (($_POST['submit']l == "Add") || ($_POST['submit'] == "Update")) {
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$adabasEmployee = array (
'personnel_id" => $Persid,

'first_name' => $Fname,
"name’ => $Lname,
'city' => $City,

'address_line' => $Addr
)

$adabasEmployees = array($adabasEmployee);

if ($_POST['submit'] == "Add") {
try |
$Adabasresponse = $soapclient->add($adabasEmployees);
} catch (SoapFault $soapfault) {
echo "<pre>";
print_r($soapfault);
echo "</pre>";
}
b else {
try |
$Adabasresponse = $soapclient->update($adabasEmployees);
} catch (SoapFault $soapfault) {
echo "<pre>";
print_r($soapfault);
echo "</pre>";
}
}
}
} else {
}
7>
<html>
<head>
<title>Personnel Info</title>

</head>

<body>

<font face="courier">

<form method="post" action="<?php echo $PHP_SELF;?>">

Personnel Id: <input type="text" size="8" maxlength="8" name="Persid" value="<? «
echo $Persid; ?>"><br />

First Name..: <input type="text" size="20" maxlength="20" name="Fname" value="<?
echo $Fname; ?>"><br />

Last Name...: <input type="text" size="20" maxlength="20" name="Lname" value="<?
echo $Lname; ?>"><br />

City........: <input type="text" size="20" maxlength="20" name="City" value="<? «
echo $City; ?2>"><br />

Address.....: <input type="text" size="20" maxlength="20" name="Addr[]" value="<? «
echo $Addr[0]; ?>"><br />

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp; ... .. : input type="text" size="20" <
maxlength="20" name="Addr[]" value="<? echo $Addr[11; ?2>"><br />
&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;.....: <input type="text" size="20" «
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maxlength="20" name="Addr[]" value="<? echo $Addr[2]; ?>"><br />

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;.....: <input type="text" size="20" «
maxlength="20" name="Addr[]" value="<? echo $Addr[31; ?>"><br />
<br/>

<? echo $msg; ?><br><br>

<input type="submit" value="List" name="submit">

<input type="submit" value="Get" name="submit">

<input type="submit" value="Add" name="submit">

<input type="submit" value="Update" name="submit">

<input type="submit" value="Delete" name="submit">

<input type="submit" value="Reset" name="submit">

</form>

<?

if (isset($_POST['submit'])) {

if ($_POST['submit'] == "List"') {
echo "Selected: Personnel Id=''".$Persid."'', <
first_name='"'".$Fname.""'"',Name=""".$Lname;
echo "'', City=""".$City."""'<br/><br/>";

$1istkey = array('personnel_id' => $Persid, 'first_name' => $Fname, 'name' => <«
$Lname, 'city' => $City);

try {

$listresponse = $soapclient->1ist($1istkey);
} catch (SoapFault $soapfault) {

echo "<pre>";

print_r($soapfault);

echo "</pre>";

return;

}

echo "<table border=1 cellpadding=5>";
echo "<tr><th>Personnel Id</th><th>Name</th><th>First Name</th><th>City</th><th <«
width=200>Address Line</td>";

if ( isset($listresponse->adabaskEmployees->adabasEmployee) )
{

$Employees = $listresponse->adabaskEmployees->adabaskEmployee;
if (lis_array($Employees))

$Employees = $listresponse->adabasEmployees;

foreach ($Employees as $Employee) {
echo <
"<Er<td>$Emplayee->personnel_id</td><td>$Emplayee->name</td><td>$Empl ayee->first, name</td><td>$Employee->city</td><td>";

echo "<table>";

if (!lis_array($Employee->address_line)) f{

echo "<tr><td width=200>$Employee->address_line</td></tr>";
} else {

foreach ($Employee->address_line as $addr) {
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26 empMiniList.rb (Ruby)

require 'soap/wsdIDriver'
wsdl_url = "http://soagate:8023/adabas_EmployeesMini?WSDL"
soap = SOAP::WSDLDriverFactory.new( wsdl_url ).create_rpc_driver

soap.wiredump_file_base = "soapresult"

param = {"personnel_id" => "50005*", "name" => "", "city" => ""}

result = soap.list( param )

print( "\nNumber of Employees is
ll\n\nll)

, result.adabasEmployees.adabasEmployee.length,

for emp in (result.adabasEmployees.adabasEmployee)

print(emp.personnel_id, ", ", emp.name,

, emp.first_name, "\n")

end
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27

ASGDemo.cs

using System;
using System.Collections.Generic;
using System.Text;

namespace Employeeslist

{

class Program

{

static void Main(stringl[] args)

{

adabasEmployeesService emplService;
adabasEmployeeKeyType keys;
adabasEmployeesElementType result;
adabasEmployeeTypel[] empl;

keys = new adabasEmployeeKeyType();
keys.personnel_id = "300000*";

emplService = new adabasEmployeesService();

try

{
result = emplService.list(keys);

}

catch (SystemException ex)

{
Console.Writeline("exception: " + ex.Message);
return;

}

empl = result.adabasEmployees;

if (empl.Length > 0)
{

Console.WritelLine("Number of Employees returned:

+ empl.Length);
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MySQL_City.cs

using System;
using System.Collections.Generic;
using System.Text;

namespace Citylist

{

class Program

{

static void Main(stringl[] args)

{

RootETementNameService cityService;
GroupElementNameKeyType key;
RootElementNameElementType result;
GroupETementNameTypel[] aCity;

key = new GroupElementNameKeyType();
key.ID = "305*";

cityService = new RootElementNameService();

try

{
result = cityService.list(key);

}

catch (SystemException ex)

{
Console.Writeline("exception: " + ex.Message);
return;

}

aCity = result.RootElementName;
if (aCity.Length > 0)

{
Console.WriteLine("Number of Cities returned:

" + aCity.Length);
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29  FEw (LOB demo file) FDT

ADACMP COMPRESS FILE=90
ADACMP FNDEF="1, AA, 8, A ,DE, UQ'
ADACMP FNDEF=1,LM,32, A ,NU"

ADACMP FNDEF='1,LB,0, A ,LB, NV'
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30 FILE 90 (LOB demo file) load parameters

= Sample load parameters for the 'hase' file ... 134
= Sample load parameters for the 'LOB' file ..........vvviiiiiiiiii e 135
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FILE 90 (LOB demo file) load parameters

Loading a LOB file involves two steps

1. loading the 'base’ file
2. loading the LOB file

Sample load parameters for the 'base’ file

//DDKARTE DD *

ADALOD LOAD FILE=90

ADALOD NAME=ASG-PHOTOS
ADALOD LOBFILE=91

ADALOD MAXISN=100

ADALOD DSSIZE=10B

ADALOD UISIZE=5B

ADALOD NISIZE=10B

ADALOD INDEXCOMPRESSION=YES
ADALOD ISNREUSE=YES

ADALOD LWP=1024K

ADALOD SORTSIZE=<sortsize>
ADALOD SORTDEV=<sortdev>
ADALOD TEMPSIZE=<tempsize>
ADALOD TEMPDEV=<tempdev>

/*
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Sample load parameters for the 'LOB' file

//DDKARTE DD *

ADALOD LOAD FILE=91
ADALOD NAME=ASG-PHLOBS
ADALOD BASEFILE=90
ADALOD MAXISN=100
ADALQOD DSSIZE=100B
ADALQOD UISIZE=5B

ADALQOD NISIZE=10B

ADALQOD ISNREUSE=YES
ADALOD LWP=1024K

ADALQOD SORTSIZE=<sortsize>
ADALOD SORTDEV=<sortdev>
ADALOD TEMPSIZE=<temspize>
ADALOD TEMPDEV=<tempdev>

/>(-
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31 FILE90.FDT (LOB demo file FDT)

1, AA, 8, A, DE, UQ ; personnel_id
1, M, 32, A, NU ; mime type for LOB

1, LB, 0, A, NB,NV,LB ; LOB data
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32 FILE90.FDU (LOB demo file load parameters)

dbid = 212
file = 90
name = photos
Tobfile= 91
dssize = 50b
nisize = 10b
uisize = 5b
maxisn = 100

reuse = (isn,ds)
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33 wsf_lobGet.php

Get a record from the Adabas demo file and save the LOB to a file, the extension is determined

from the mime-type stored on the file,
<?php
$id = $_GET["id"'1;

$reqPayloadString = <KKXML

<emp:EmployeePhotoGetETement xmlns:emp="com.SOAGateway/EmployeePhoto">

<personnel_id>$id</personnel_id>
</emp:EmployeePhotoGetETement

> XML;

try {

$client = new WSClient(
array("to"=>"http://localhost:56000/adabas_blobs",
"useMTOM"=>TRUE,

"responseX0P"=>TRUE));

$reqMessage new WSMessage($reqPayloadString);

$resMessage new WSMessage('');

$resMessage = $client->request($reqMessage);

printf("Response = %s \n\n", $resMessage->str);
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$cid2stringMap = $resMessage->attachments;
$cid2contentMap = $resMessage->cidZ2contentType;
$imageName;

if($cid2stringMap && $cid2contentMap)
foreach($cid2stringMap as $i=>$value){

$f = $cid2stringMapl[$il;

$contentType = $cidZ2contentMapl[$il;
if(strcmp($contentType,"image/pjpeg") ==0){
$imageName = "C:A\\NTEMPA\".$i."."."jpg";
file_put_contents($imageName, $f);

echo "<pre>File saved as ".$imageName."</pre>";
}

if(strcmp($contentType,"image/gif") ==0){
$imageName = "C:\\TEMP\\".$i."."."gif";
file_put_contents($imageName, $f);

echo "<pre>File saved as ".$imageName."</pre>";
}

if(strcmp($contentType, "audio/mpeg") ==0){
$imageName = "C:\\NTEMPA\N".$i."."."mp3";
file_put_contents($imageName, $f);

echo "<pre>File saved as ".$imageName."</pre>";
}

}

felsel

printf("attachments were not found ");

}
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} catch (Exception $e) {

if ($e instanceof WSFault) {
printf("Soap Fault: %Zs\n", $e->Reason);
b else {

printf("Message = %s\n",$e->getMessage());
}

echo "<pre>";

print_r($e);

print_r($reqMessage);
print_r($resMessage);

echo "</pre>";

}
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35 Usage Governance Tutorials

Usage Governance can be reported in 3 ways and written to 3 output types.

® Using the local file system
® Using another SOA Gateway
® Using MOM
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Using the local file system

Tutorial: Write Usage Governance data to the local file system

N o ok W

. Select the Governance tab in the Properties view.

. In the Control Centre select the server for which usage governance data will be generated.

To turn data collection on the Information box must be selected. If required Input Data and

Output Data may also be selected.

 Portus Contral Centre (Ac
File Edit Navigate Search Project Run Window Help
Bl Q-4 -5~ -
O)\Portus 73 25 @ ¥ = B[ properties i1
< | Bocalhosy localhost (localhost:56421) - v4.2.1.002000 (Jul 12 2012 / 12:50:42)
) Serviees
. [ DataViews T Usage Governance settings
[ BusinessDataView: Tracing
~ Basic ~ Messaging
Global

Drivers ™ Information Max, File size
Governance I Input Data

Statistics 7 output Data

= Governance Server

Hast
Port:

Select the Save button.

Stop the server.See here on how to do this.

Start the server.

Issue a request to SOA Gateway e.g. a get request.
Go to SOA Gateway configuration directory.

EntireX |MQ5
Broker Stub
Broker ID
Class

Server

Service

eeeee

[ i+ Portus (legac... | {) Portus Control ”

Edal=]

H ~

The default location of SOA Gateway configuration folder is [SERVER_INST]/Apache22/config-
uration replacing [SERVER_INST] with the location in which you have installed SOA Gateway.
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Using the local file system

8. A file should be present in the format soag_usage_governance_yyyy_mm_dd_hh_mm_ss_ms.txt.
Note that it is not possible to view this file while SOA Gateway is running. Stopping the server
will create an XML file with the same name.

9. Open the file to check its contents.

10. There should be 1 entry for the get request plus all the governance data collected as per the
options selected in 2.
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37 Using another SOA Gateway

Tutorial: Writing Usage Governance data to another SOA Gateway

1. In the Control Centre select the server for which usage governance data will be generated.
2. Select the Governance tab in the Properties view.

To turn data collection on the Information box must be selected. If required Input Data and
Output Data may also be selected.

3. The Governance Server section is where we enter the details for another SOA Gateway:.
® Host : the IP address for the server.
" Port : the port number of the server.

4. Enter these and save.

File Edit Navigate Search Project Run Window Help

[ BusinessDataViews T

Global -
Drivers ™ Information Max, File size il Use  None % EntireX © MQ
Governance I Input Data

Entireit | M Series |
Statistics 7 output Data

~ Basic ~ Messaging

Broker Stub |
~ Governance Server

Broker ID |

Host
? e

Part
I
I

Server

Service

5. Stop the server. See here on how to do this.
6. Prior to restarting the server the following must be observed:

® The Governance Server is running i.e. that SOA Gateway with the host and port number
entered has been started and is awaiting requests.

] Q- A -5~ - - 59 i Portus (legac.. B
O Partus 2 +5 " 7 7 02 Properties =~ =Aa
4 | > _localhost localhost (localhost:56421) - v4.2.1.002000 (Jul 12 2012 / 12:50:42)
) Serviees
. [ DataViews e Usage Governance settings E

= Ponus Control Centre (Ac ==

!
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Using another SOA Gateway

* The governance web service, usagegovernance, has been created successfully and is loaded.

If this has not yet been done, following the instructions here to do this.

Start the server. See here on how to do this.

On startup an initial connection is made to the governance server to verify its details. If this is

unsuccessful an appropriate error will be written to the error log so this should be checked

now.

The default location of the Apache error_log is [SERVER_INST]/Apache22/logs/error_log repla-
cing [SERVER_INST] with the location in which you have installed SOA Gateway.

9.

Issue a request to SOA Gateway e.g. a list request.

10. There are a couple of ways to check that the data collection has reached its destination.

" Query the database table directly..

" Issue a list request on the usage governance web service e.g.

..

=]
‘[ | Risars Ltd, SOA Gateway Usage Governanc, |T‘ -
&) 3 Iocahost:58005 usagegovemance TLISTRG Group=" |41 Alla B
Portus O
Usage Governance Data
Service [Version Status|Operation Start Time End Time [ruput utput Local T2 ™™™ [Method User Tnput Time Tnput ~[Output Time Cutput
Length  [Length ™
MyCiey [L Test [list [012-02-17T16:15:25.752[2012-02-17116:15:25.752 7 [ss05 127001127001 [GET R012-02-17T16:15:25.752 | DAt |[2012-02-17T16:15:25.752_paTa
My City |1 Test [list (2012-02-17T16:15:36.297 [2012-02-17T16:15:36.329 27 38935 127.0.0.1127.00.1 |GET 2012-02-17T16:15:36.297 | DATA |2012-02-17T16:15:36.329 | DATA
My City |1 Test [list (2012-02-17T16:15:47.264 2012-02-17T16:15:47.295 27 41885 127.0.0.1127.00.1 |GET 2012-02-17T16:15:47.264 | DATA |2012-02-17T16:15:47.295 DATA

Copyright Ostia Solutions

py
Ostia
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38 Using MOM

Tutorial: Write Usage Governance data to a MOM system

Usage Governance data can be written to a WebSphere MQ queue or an Software AG EntireX
server.

It is outside the scope of this tutorial to detail exactly how these are set up so it is assumed that
the chosen Messaging system is configured correctly.

In this tutorial we will be using 2 SOA Gateway servers. One will direct usage governance data
collected to a message queue and the other will read from this queue and process the input. The
end result is that the target of the usage governance web service will receive an add request com-
plete with the data.

1. In the Control Centre select the server for which usage governance data will be generated.

2. Select the Governance tab in the Properties view.
To turn data collection on the Information box must be selected. If required Input Data and
Output Data may also be selected.

3. The Messaging section allows one to enter the details required for None, MQ or EntireX:
Select the radio button of MQ or EntireX and fill in as appropriate for you MOM installation.

Note that the queue will be opened for output and later on in this tutorial will be opened as an
input queue.
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NN O O W

| = Portus Control Centre (Administratic
File Edit Navigate Search Project Run Window Help
e YR e B 4 Porus fegac.. z
O Portus & =5 I8 7 7 O Properties ®7Y=a
L ‘“’O“‘h;“ localhost (localhost:56421) - v4.2.1.002000 (Jul 12 2012 / 12:50:42)
Y ervices
. [ DataViews e Usage Governance settings =
(1) BusinessDataViews Tracing :
~ Basic ~ Messaging
Global -
Drivers ™ Information Max, File size Use  None % EntireX © MQ
Governance I Input Data
EntireX |MQS eeeee |
Stafistics I output Data
Broker Stub |
~ Governance Server
Broker ID |
Host
Class |
Part
Server |
Seniics |
=0a

. Select the Save button.
. Stop the server. See here on how to do this.
. Start the server.

. At this point SOA Gateway should have connected successfully to the manager and opened

the output queue specified. Check the error log for any errors at this point.

The default location of the Apache error_log is [SERVER_INST]/Apache22/logs/error_log repla-
cing [SERVER_INST] with the location in which you have installed SOA Gateway.

Issue a request to SOA Gateway e.g. a get request

An add request, containing usage governance data pertaining to this request, should appear

as an entry in the output queue.

Use a search mechanism particular to your messaging system to check that this is the case. Note
the syntax of this request is supported by the usage governance web service. If the latter has
not yet been created, follow the steps outlined here to do so.

10. In the Control Centre, select the second SOA Gateway server. Open the Messaging tab in the

Properties view for the usagegovernance web service:
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& S0A Gateway Control Centre {Administration) - Eclipse SDK

File Edit Mavigate Search Project Run  Window Help

lJ = J‘%-J@ Q"'vJ - L == - [ G web [ Resource
) Partus i3 = O || = properties 52
%5 " | local : Service properties
= ;___'?fagewm @ @ Messaging properties for Service ‘'usagegovernance' (¥1)  switch back to service properties to update service defintion

- 2R adabas Driver Messaging
L N—————

E Datatiews Threads ll—

B8] BushessDataens Use € Mone & EntireX € MO

w* Messaging

Entirex | MQ Series |

Broker Stub I

Broker IO

Server

Class I

Service

11. Fill in the details for the messaging system you are using. Clearly, for MQ, the Input Q value

has to be the value specified for Queue in step 3. For EntireX the details entered here should
match those from 3.

| Note: The Broker Stub value will depend on the system from which EntireX is being
called i.e. broker32.dll for Windows, broker.so for Linux etc.

12 As per the hint, switch back to Service properties and select the Save button when complete.
13. SOA Gateway will now make contact with the appropriate messaging system. Check the error
log for messages.
The default location of the Apache error_log is [SERVER_INST]/Apache22/logs/error_log repla-
cing [SERVER_INST] with the location in which you have installed SOA Gateway.
14 As soon as successful connections have been made, the input queue/service will be read and
the message(s) processed.
There are a couple of ways to check the status of this.
" Query the database table directly..

" Issue a list request on the usage governance web service.

® Check the Output Q (MQ) or the EntireX server for responses to the add request to the usage
governance web service.
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39 Create the usagegovernance web service

The usagegovernance web service is a bespoke service which is mandatory if usage governance
data is being collected on a separate SOA Gateway. Here are the steps required to create it.

1. In the Control Centre select the server on which usage governance data will be stored.

2. Click on the View Menu icon and select the Enable special context functions entry.

File Edit Mawigate 3Search Project 304 Gateway Run Window  Help

I = —
| £5 - -l -
B3 508 Gateway 52 i L Eq(ﬂ Properties 23
= M #58dd new S04 Gateway connection
B Services £* Deploy installation files to server
- Datavi
E Ba fa IE%S e Save Control Centre Server definitions
all] BLsinessDataviews Load Control Centre Server definitions
Enahle special context Functions

3. Under Services select the driver which will support the new service. If one has not yet been
created add one now. See here for details on this.

Right click on the driver entry and select the Create Usage Governance Service item.
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4.

5. The web service is now created and its properties displayed .

-
Ed 504 Gateway 52 = Eq =l Properties 53

2 B 7

=B local Properties are not availabl

[Fl-iat Services

: ----- i@ rdabas Driver
B8 ws Driver  [5|Discover Service(s)
-] Dataviews 25 Add Service

| BusinessDataViews

Es

# Remove Driver

_teabe Lsage Governance Service

Fill in the details appropriate to your installation.
Select the Create database table now check box.

Select Create.
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40 SOAP over EntireX Tutorial

Tutorial: Send SOAP requests to EntireX

SOA Gateway and EntireX can be used together to enable sending SOAP requests to an EntireX
service and to receive a response from a service. These request are asynchronous so it means that
multiple requests can be sent from the client even though SOA Gateway may not be running.
These requests are held until SOA Gateway reads and processes them. Likewise the responses are
retained until such time that a client may request them.

Here is a top level view on the steps involved.

® For a particular web service specify the Broker details required.

® The resultant WSDL for the web service can be read by a client which will enable it to generate
the appropriate SOAP request to send to the service.

* The resultant WSDL for the web service can be read by a client which will enable it to generate
the appropriate SOAP request to read from the service.

Details

This tutorial will make use of Java wrapper/stub classes to access a SOA Gateway Service.
Java wrapper/stub classes are generated using the Apache Axis2 feature WSDL2]Java.

If you do not have it already, download and install the latest Axis2 kit.

The web service which we will be using is that described by the "adabas_EmployeesMini" DataView
supplied with SOA Gateway.

1. Select the adabas_EmployeesMini web service and open the Messaging tab. Select the EntireX
radio button and tab. Fill in the details appropriate to your installation.

| Note: The Broker Stub value will depend on the system from which EntireX is being

called i.e. broker32.dll for Windows, broker.so for Linux etc.
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,

File Edit Navigate Search Project Run Window Help

v Qv A Gl G B i Portus (legac... [0
) Portus &2 235 §* ¥ = O|[E properties 22
4 | » Joealies localhost : Service properties
4 ) Services

2 [ Adabas_Driver properties | @ Messaging properties for Service ‘adabas_EmployeesMini_v1’ {v1)  Switch back to service properties to update service definition

Messaging

A adabas Empl
() bdvDriver
> st MySQL_Driver
N Natural_Driver

fini vl (v1)

Threads 1

& WS Driver Use @None @ EntireX (O MQ
» [ DataViews n 3
— Ent MQ Series
[ BusinessDataViews ".‘ ]

Broker Stub
BrokerID
Class
SEREr

Senice

2. As per the hint, switch back to service properties and select the Save button when complete.

3. SOA Gateway will now make contact with the EntireX Broker. If an error occurs it will be

highlighted as shown below.

Check the error_log to find the cause. The default location of the Apache error_log is [SERV-
ER_INST]/Apache22/logs/error_log replacing [SERVER_INST] with the location in which you
have installed SOA Gateway. Please correct and try again.

If successful then carry on to next step.

R —
ion) - adabas_Employ

File Edit Mavigate Search Project Run Window Help

-
= Portus Control Centre (Admini:

i Q- F s S
11 Pertus 52 #5 @ 7 T O | & Properties 2
4 | b locleer localhost : Service properties
a O Services
s A Adabas Driver Properties @ Properties for Service ‘adabas_EmployeesMini_v1' (v1) 1 eror detected

¢® adabas_EmployeesMini_vl (v1) e

) bdvDriver  Service Definition H ~ Service Settings
b e MySQL Driver
N MNatural_Driver Name o adabas_EmployeesMini_vl [ write Byte Order Mark (BOM)
& WS Driver .
» [5 DataViews Driver Adabas_Driver &7 Read-only [}
[[7 BusinessDataViews SBCS-Codepage

. Switch to the Java perspective (Window -> Open Perspective -> Other... -> Java (default). For
more information on this aspect of Eclipse see Getting started with Eclipse.

. Create a new Java-project naming it "SOAPEntireXTutorial".

. Right-click the "SOAPEntireXTutorial" project folder, select "Build Path", then "Add External

Archives.."

Add all jar files from the axis2 "lib"

Archives.."

directory to the project's Build-Path.

Right-click the "SOAPEntireXTutorial" project folder, select "Build Path", then "Add External

Add the entirex jar files from your EntireX installation e.g. ..\ SoftwareAG\ EntireX\ classes
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10. Open a command prompt (aka "DOS box"), change to the "SOAPEntireXTutorial \ src" directory
and run the following command:

wsdl2java -uri http://<yourserver>:<yourport>/adabas_EmployeesMini? WSDL -0 ..\ -p SoaGW

[&+|Administrator: Command Prompt =13 x|

oft Windows [Uersion 6.8.686811
Copyright (c> 2886 Microsoft Corporation. All rights reserved.

C:slUserssJohnied N
IC:w>cd workspaceDemo~SOAPEntirelTutorialssre

G sworkspaceDemos\SOAPEnt irekTutorialssreduwsdl2 java —uri http:/slocalhost:56805/adabas_EmployeesMini?WSDL —o ..% —p SoaGll
Using AXIS2_HOME: C:ivaxis2-1.5.4

Using JAVA_HOME: C:~Program FilesJavaxjdkl.5.68_14

Retrieving document at *http:~/slocalhost:56085adabas_EmployeesMini?WSDL’ .

Retrieving schema at 'http://localhost 568685800 _GATEWAY CONFIGURATION_DIRECTORY. schemaspublic_xsd/xmlmime.xsd’. relative to
*http:/slocalhost :56805 adabas_EmploveesMini?WSDL’ .

IC:“workspaceDemo \SOAPEntireXTutorialssrc

11. The following items are generated from the SOA Gateway WSDL:
= A'"Stub" class implementing all types and operations ( ports / bindings ).

= A CallbackHandler - a stub class (not used in this tutorial) providing hooks for client-side
extensions to the generated result- and error handlers.

" A Fault class.

12 Get file SOAPEntireXTut.java and, when prompted, save in the ..\ SOAPEntireXTutorial \ src\ So-
aGW directory. Right-click on SOAPEntireXTutorial and select Refresh(F5). SOAPEntireXTut.java
should appear in the explorer window.

13. Get file exxTransports-0.1.jar and, when prompted, save it in a local directory.

14 Right-click on SOAPEntireXTutorial and select Build Path -> Add External Archives...

Navigate to where exxTransports-0.1.jar was saved and select Open to add it the project.
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& Java - Eclipse SDE

File Edit Source Refactor Mawigake Search Project Rum Window  Help

et [0 - Q- |[E# G- |@c 5] - oo -
P
[% Package Explorer 532 = <,1=’=§ = quf
EL:‘,J- SICAPERtireRTUkGria] ”
E:% st Mew 3
EI:-E} SoaEhl 2o Inka
- 4] Adabast
: ] Adabas Cpen in New Window
[+ 11| Adabast .
m Fault.ja: Qpen Type Hierarchy F4
Cd ' Shiow In Alt+Shift-+ 3
- [J] SOAPER
(- JRE System Libr. ||| Copy Chrl4C
E'.a Referenced Libr. 5= Copy Qualified Mame
451 buid, ‘: Paste Chrl+
3 Delete Celete
Remove from Contexk L e | e L

Build Path | Z5Link Source. .

SoupCe Alt+-Shift+5 * 5iMew Source Folder,..
Refactar Ble+shift+T »
L #Use as Source Folder
E2gImpart. .. B add External Archives. ..
e3Export. .. = add Libraries. ..
7 Refresh Fa s Configure Build Path. ..
Close Projeck
Bssign Warking Sets. ..
AU Be p [lEmms (@ Javadoc (@ Cieclaration ﬂ;
Debug As p jtedz SoapClientSendReceive [Java Ap
Profile fs »
Yalidate
Team 3
Compate Wikh »
Restare from Local Histary, ..
Configure r
Propetties Alk+Enter

15. Right-click on the file and select Run As ->Java Application:
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& Java - SOAPEntireXTutorial/src/SoaGW /SOAPEntireXTut.java - Eclipse SDK

File Edit Source Refactor Mavigate Search Project Run Window Help

I3~ [#-0-A-|#E@-|®S -] FaRSIR SIS

ackage Explorer = 08| AdabasEmploveesServicestub, java m SOAPEREirexTuUL. jay
{2 package Explarer £3 ==
EI:;‘J- SOAPERkirexTukorial package ZIoaGl;
58 o
EBE SoaiGw “import org.apache.axis:d.description.Tr
m AdabasEmploveesServiceallbackHandler java
m AdabasEmploveesServiceStub, java import com.risaris.axisZ.entirex.trans
m Fault,java imnnrt cop,risaris.axisi.entirex. trans
Mew 3
B2 JRE Swstem Library [JavasE- Open F3 S G, AdakbssEnp loyeesService3ty
: B8\ Referenced Libraries Open With y BGU. AdabasEmployeesServicesSty
7@ build, ol Open Type Hisrarchy F4 A Gl . AdabasEmp loyeesService3t:
Show In [ y AGW. AdsbasEmp loyees3ervicedty
=G, AdsbasEnp loyeesdervicedty
|{= Copy Chrl+C
E= Copy Qualified Mame
:'-5 Paste Chrl+y ass SOAPEntireXTut |
3 Delete Delete
e static void maini(3tring[] =
Reemawe fram Contesxt Chrl-AlE+Shift+ Do
Build Path ' dabasEmployeesService3tubh stu
Source Alt-+5Shift+35 »
Refactor AltShift+T ; ransporcouthescrivtion txout
g Import...
L EXpatt. .. adac (@ Declaration (E Cansale &3
References , entSendreceive [Java Application] C:\Program
Declarations »
q)(‘,; Refresh F5
Assign Working Sets, .,
Debug As L4 a Application Alk+Shifl
Profile As 3
validake Run Configurations. ..

16. The output appears in the "Console" window:

{21 Prablems (@ Javadoc (@ Declaration (E Console 23 ® 5
<terminated > SoapClientSendReceive [Java Application] C:\Program Files|Javaljreatibintjavaw exe (26 Jul 2011 15:47:47)

log4]j:WARN No appenders could he found for logger (org.apache.axisi.description.lixisZervice).
logdj:WARN FPlease initialize the logdj system properly.

Employee: 11100108 WOLFGANG GRIESHEIM

Employes: 11100109 Christa Griesheim

Employee: 11100107 Helga Heppenheim
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